VoiceOver
Getting Started
Includes instructions and complete command lists for using VoiceOver with Mac OS X version 10.4 Tiger.
Contents

Chapter 1  6 Introduction
6 About VoiceOver
7 What You Need to Get Started
7 Using This Document
8 Where to Find More Information
8 VoiceOver Quick Start
8 VoiceOver Help
8 VoiceOver Menu
8 Mac OS X Keyboard Shortcuts
9 Resources on the Internet
9 Teaching and Learning Tools
9 Darkening the Screen
9 VoiceOver Quick Start Application
9 VoiceOver Keyboard Commands Diagrams
10 About VoiceOver Accessibility

Chapter 2  11 Introduction to Mac OS X
11 The Desktop
12 The Finder
12 Toolbar Buttons
12 Sidebar and View Browser
13 The Dock
13 The Menu Bar
14 Files and Folders
14 System Preferences
15 Spotlight

Chapter 3  16 Keyboard Basics
16 Important Keys to Know
17 About Function Keys
18 Using Function Keys on Portable Computers
18 Using Home, End, Page Up, and Page Down on Portable Computers
18 Keyboard Accessibility
Chapter 4  VoiceOver Basics
22  Following Instructions
22  Turning On VoiceOver
23  Using VoiceOver in the Login Window
23  Pausing VoiceOver Speech
23  Controlling VoiceOver
24  Reading Window Contents
25  Reading Text
25  Changing Rate, Pitch, and Volume Temporarily
26  Interacting With Content Areas
27  Using Buttons and Controls
28  Learning More About an Item
28  Navigating Menus
29  Navigating Quickly in a Menu
29  Using Pop-up Menus
29  Using Contextual Menus
30  Understanding Duplicate Menu Items
30  Working With the VoiceOver Menu
31  Using the Commands Menu
32  Chapter 4 Exercises
32  Exercise 4.1: Moving the VoiceOver Cursor
32  Exercise 4.2: Interacting With a Content Area
32  Exercise 4.3: Navigating the Menu Bar
33  Exercise 4.4: Navigating in a Menu and Submenu
33  Exercise 4.5: Using the VoiceOver Menu

Chapter 5  Using VoiceOver With Mac OS X
34  Using the Dock
35  Setting Dock Preferences
35  Working With Contextual Menus for Dock Items
35  Switching Between Applications and Windows
37  Navigating Finder Windows
38  Using Icon View
38  Using List View
39  Using Column View
40  Accessing Finder Window Buttons
40  Selecting Files and Folders
41  Copying and Moving Files
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>66</td>
<td>Opening Collapsed Folders in the Mailboxes Outline</td>
</tr>
<tr>
<td>67</td>
<td>Reading Email</td>
</tr>
<tr>
<td>68</td>
<td>Addressing a Message</td>
</tr>
<tr>
<td>68</td>
<td>Using the Safari Web Browser</td>
</tr>
<tr>
<td>68</td>
<td>Navigating Websites With VoiceOver</td>
</tr>
<tr>
<td>69</td>
<td>Using the Link Chooser Menu</td>
</tr>
<tr>
<td>70</td>
<td>Navigating Website Images</td>
</tr>
<tr>
<td>70</td>
<td>Chapter 7 Exercises</td>
</tr>
<tr>
<td>70</td>
<td>Exercise 7.1: Opening and Reading an Email Message</td>
</tr>
<tr>
<td>70</td>
<td>Exercise 7.2: Using the Link Chooser Menu</td>
</tr>
<tr>
<td>72</td>
<td>Chapter 8 Exercises</td>
</tr>
<tr>
<td>72</td>
<td>Reading and Editing Text</td>
</tr>
<tr>
<td>72</td>
<td>Reading a Document</td>
</tr>
<tr>
<td>73</td>
<td>Working With Text</td>
</tr>
<tr>
<td>73</td>
<td>Locating the Insertion Point</td>
</tr>
<tr>
<td>73</td>
<td>Navigating in a Document</td>
</tr>
<tr>
<td>74</td>
<td>Bookmarking a Document</td>
</tr>
<tr>
<td>74</td>
<td>Cursor Tracking in Text Areas</td>
</tr>
<tr>
<td>74</td>
<td>Selecting Text</td>
</tr>
<tr>
<td>75</td>
<td>Hearing Text Attributes</td>
</tr>
<tr>
<td>75</td>
<td>Using TextEdit With VoiceOver</td>
</tr>
<tr>
<td>75</td>
<td>Checking Spelling in TextEdit</td>
</tr>
<tr>
<td>76</td>
<td>Changing Tab Stops in TextEdit</td>
</tr>
<tr>
<td>77</td>
<td>Chapter 8 Exercises</td>
</tr>
<tr>
<td>77</td>
<td>Exercise 8.1: Following the Insertion Point</td>
</tr>
<tr>
<td>77</td>
<td>Exercise 8.2: Cutting and Pasting Text</td>
</tr>
<tr>
<td>78</td>
<td>Exercise 8.3: Saving a Document</td>
</tr>
<tr>
<td>79</td>
<td>Chapter 9 Exercises</td>
</tr>
<tr>
<td>79</td>
<td>Advanced Navigation Skills</td>
</tr>
<tr>
<td>79</td>
<td>Full Keyboard Navigation and VoiceOver</td>
</tr>
<tr>
<td>79</td>
<td>Advanced Cursor Tracking</td>
</tr>
<tr>
<td>80</td>
<td>Using the Cursor Control Keys</td>
</tr>
<tr>
<td>81</td>
<td>Using the Mouse With VoiceOver</td>
</tr>
<tr>
<td>81</td>
<td>Mouse Settings in VoiceOver Utility</td>
</tr>
<tr>
<td>82</td>
<td>Making the Mouse Pointer More Visible</td>
</tr>
<tr>
<td>82</td>
<td>Using the Numeric Keypad to Control the Mouse</td>
</tr>
<tr>
<td>83</td>
<td>Quickly Navigating to Content Areas</td>
</tr>
<tr>
<td>83</td>
<td>Chapter 9 Exercises</td>
</tr>
<tr>
<td>83</td>
<td>Exercise 9.1: Using Command-Tab to Switch Applications</td>
</tr>
<tr>
<td>84</td>
<td>Exercise 9.2: Moving Cursors Independently</td>
</tr>
<tr>
<td>85</td>
<td>Appendix</td>
</tr>
<tr>
<td>85</td>
<td>VoiceOver Commands</td>
</tr>
</tbody>
</table>
Welcome to VoiceOver Getting Started. This document introduces you to VoiceOver and gets you started using your Mac in a new way.

VoiceOver is an alternative way for users with visual or learning disabilities to use Mac OS X. It provides magnification options, keyboard control, and spoken English descriptions of what's happening on the computer screen. VoiceOver reads aloud the contents of documents (and webpages) and provides a comprehensive audible description of the user's workspace and activities taking place on the computer. It also includes a rich set of keyboard commands for navigating the Mac OS X interface and interacting with application and system controls.

About VoiceOver
VoiceOver is an integrated part of the Mac OS X operating system. If your computer has Mac OS X version 10.4 or later installed, VoiceOver is already installed and ready to use. Just turn on VoiceOver to begin using it.

VoiceOver works in conjunction with full keyboard access, the standard Mac OS X keyboard navigation method. With full keyboard access, you can use the Tab key and arrow keys to move to controls and text fields in windows, and the Space bar to select or activate them. But when you use VoiceOver, you can do so much more.

VoiceOver uses keyboard commands to navigate your computer screen, windows, documents, and websites. It reads aloud everything it encounters and lets you know when events occur on your screen, such as when dialogs, alert messages, and progress bars appear.
What You Need to Get Started
To use VoiceOver, you need:
- A Macintosh computer with Mac OS X version 10.4 or later installed
- An English language Apple keyboard
- Built-in or external speakers or headphones

A mouse and display are optional. If you don’t need a display or mouse, you can use VoiceOver without them.

An Internet connection is highly recommended.

Using This Document
This document is a comprehensive guide to using VoiceOver. It is organized into 11 chapters with a VoiceOver commands appendix. You can read the chapters in any order you choose, but if you are new to Mac OS X and to VoiceOver, you will find that reading them in the order presented lets you build upon knowledge gained in previous chapters.

- **Chapter 1, “Introduction”:** In this chapter, you learn what VoiceOver is, what you need to get started using it, and where to find more information about VoiceOver.
- **Chapter 2, “Introduction to Mac OS X”:** In this chapter, you learn Mac OS X basics that will help you use VoiceOver effectively. It includes a description of the screen layout, windows, Finder, and System Preferences.
- **Chapter 3, “Keyboard Basics”:** In this chapter, you learn which keys control VoiceOver. You also learn about keyboard practice and how to set preferences in Mac OS X and VoiceOver if you have difficulty using a keyboard.
- **Chapter 4, “VoiceOver Basics”:** In this chapter, you learn the basics of controlling VoiceOver. Users who have never used VoiceOver will find out how to navigate, read text in windows and dialogs, and select controls and objects.
- **Chapter 5, “Using VoiceOver With Mac OS X”:** In this chapter, you learn how to use VoiceOver to navigate windows and perform everyday tasks on your computer using VoiceOver.
- **Chapter 6, “VoiceOver Utility and Preferences”:** In this chapter, you learn how to use VoiceOver Utility to customize VoiceOver for your needs.
- **Chapter 7, “Web Browsing and Email”:** In this chapter, you learn how to set up your Internet connection and use Mail and Safari to get email and browse the Internet.
- **Chapter 8, “Reading and Editing Text”:** In this chapter, you learn how to use VoiceOver to read and edit text and check spelling.
• Chapter 9, “Advanced Navigation Skills”: In this chapter, you learn how to use the keyboard, mouse, and VoiceOver cursor independently. You also learn how to use the mouse with VoiceOver, and about alternate ways to control the mouse.

• Appendix, “VoiceOver Commands”: In this appendix, you learn all the commands you can use to control VoiceOver.

Where to Find More Information
You can use the resources and VoiceOver features described below to learn more about using VoiceOver.

VoiceOver Quick Start
When you turn on a new Macintosh computer for the first time, you hear music play as Setup Assistant starts up. If you wait a moment, you hear a spoken invitation to learn how to use VoiceOver to set up your computer. If you are new to VoiceOver, follow the prompts to start the VoiceOver Quick Start. You will learn how to navigate with VoiceOver and interact with buttons and controls.

VoiceOver Help
Your computer comes with a built-in help system for Mac OS X and all its applications. You can access these in the Help menu in the menu bar. VoiceOver Help contains pages to help you with specific tasks, complete lists of all the keyboard commands for VoiceOver, and an orientation to VoiceOver. When you open VoiceOver Help, you can look for pages by typing keywords or phrases in the text field or by looking in the index of help topics.

You can open a complete list of all the VoiceOver commands from the VoiceOver Utility Help menu.

VoiceOver Menu
The VoiceOver menu contains all the VoiceOver commands you can apply to the item in the VoiceOver cursor. It acts as a quick reference guide as you work. When you use the VoiceOver command Control-Option-F7, the VoiceOver menu appears in the middle of the screen for sighted users. Non-sighted users can use VoiceOver navigation to read the menu and make selections.

Mac OS X Keyboard Shortcuts
You can find lists of keyboard shortcuts for Mac OS X and most applications in the built-in help system. Search for “shortcuts” or “keyboard shortcuts” or check the index if there is one. You can change or create keyboard shortcuts in the Keyboard & Mouse preference pane of System Preferences.
Resources on the Internet
The Apple website has several sections devoted to VoiceOver and accessibility. You can find additional learning materials and support information at these addresses:
- www.apple.com/accessibility
- www.apple.com/accessibility/voiceover
- www.apple.com/support/tiger/voiceover

In addition, you can find discussion groups on Apple's website and other websites to help you connect with other VoiceOver users.

Teaching and Learning Tools
If you are teaching or collaborating with a VoiceOver user, you can turn on a caption panel that displays the text that VoiceOver is speaking. For more information about the caption panel and how to customize it, see “Setting Visual Options” on page 55.

Darkening the Screen
If you are a sighted user, you can use the screen curtain to simulate a non-sighted user's experience. The screen curtain turns off all the visuals of the display, leaving a blank screen. This is a great way to learn how to use VoiceOver.

To turn the screen curtain on and off:
- Press Control-Option-Shift-F11.

VoiceOver Quick Start Application
The VoiceOver Quick Start is available as a separate application that you can use any time. Although it was designed to help users learn the basic commands necessary to set up a computer using VoiceOver, the VoiceOver Quick Start can also be used as a basic teaching tool. You can download the VoiceOver Quick Start from this Apple accessibility website: www.apple.com/accessibility/voiceover.

VoiceOver Keyboard Commands Diagrams
You can download and print keyboard diagrams that show the VoiceOver commands assigned to keys on a standard Apple English language keyboard. These diagrams are intended for use by sighted users who want a more visual way to learn the VoiceOver commands. You can download these diagrams from this Apple accessibility website: www.apple.com/accessibility/voiceover.
About VoiceOver Accessibility

VoiceOver is a new technology in Mac OS X version 10.4 Tiger. You can use VoiceOver with TextEdit, Mail, and Safari to do word processing, send and receive email, and browse websites on the Internet. You can also use VoiceOver with some other applications. As developers begin to support the underlying accessibility frameworks provided in Mac OS X, more applications will become accessible with VoiceOver. Contact the manufacturers of your favorite applications to inquire about the accessibility of their products.

Visit the Apple website to learn about new developments and resources, and check the Internet for discussion groups and user groups.
Introduction to Mac OS X

This chapter introduces you to basic information about Mac OS X.

When you understand how your computer is organized and how to use the Finder and application windows, learning to use VoiceOver is much easier. In Chapter 5, “Using VoiceOver With Mac OS X,” you will learn how to use VoiceOver with Mac OS X to complete everyday tasks on your computer.

You can find much more information about Mac OS X in Mac Help on your computer and on the Apple website.

The Desktop
The desktop is the working area of your computer that contains folders, files, and other items. When you connect to a server or connect an external hard disk or an iPod, an icon that represents it appears on the desktop. When you insert a CD or DVD into your computer’s optical drive, it also appears on the desktop.

You can store files and folders directly on your desktop for quick access.
The Finder
The Finder keeps track of files and folders and manages the desktop. When you open a folder or other item on the desktop, a new Finder window like the one shown below automatically opens.

Finder windows have a toolbar at the top and two sections below the toolbar called the sidebar and the view browser. Three colored buttons above the toolbar are used to close the window, send the window to the Dock, or change the window to its previous size. See “Accessing Finder Window Buttons” on page 40 to learn the standard Mac OS X keyboard shortcuts or menu commands to use these buttons.

Toolbar Buttons
You use the buttons in the toolbar to navigate, change the view, find items, and perform some actions.
- Use the Back and Forward buttons on the left side of the toolbar to move back and forth between locations on your computer, just as you would in a web browser.
- Use the three view buttons to choose the way you want to view the contents of your hard disk and folders. You can choose icon, list, or column view.
- Use the Action pop-up menu to choose commands you can perform for the item selected. For example, in the Finder window, some choices in the Action menu are New Folder, Get Info, or Open. In other applications, you see different choices in the Action menu.
- Use the search text field to type a word or phrase to locate an item. You can use the buttons below the search text field to focus the search to a particular location. You can choose Servers, Computer, Home, the current folder, or another location you specify.

Sidebar and View Browser
Below the toolbar, the Finder window is split into two sections. The left side is called the sidebar. At the top of the sidebar are icons that represent your hard disk, hard disk partitions if you have them, any mounted servers or volumes, and the network.
Below a separator are icons that represent often used folders on your hard disk. Mac OS X has folders already set up for you to store your music, pictures, movies, and documents. In the sidebar, you also see folders for the desktop contents, your home folder, and applications.

When a folder is selected in the sidebar, its contents are displayed on the right side of the Finder window in the view browser. Finder windows can display items in the view browser in icon, list, or column view.

**The Dock**

The Dock is a customizable list of items that provides quick access to applications and documents you use often. It appears as a row or column of icons on the screen. You can position the Dock along the bottom, left, or right edge of the screen.

When an application is open, its icon appears temporarily in the Dock. When you minimize a window, it disappears from the desktop and appears as an icon on the right side of the Dock.

Each item in the Dock has a contextual menu that gives you quick access to commands for that item. The contextual menu also contains the commands “Remove from Dock” for icons that have been placed there permanently, and “Keep in Dock” for applications that are open but whose icons are only there temporarily.

**The Menu Bar**

Mac OS X has a menu bar permanently located at the top of the screen. The menu bar contains a collection of menus for the application that is currently active. When you switch applications, the menus in the menu bar change to reflect the active application. Most applications include File, Edit, Format, Window, and Help menus.

The Apple menu, located at the far left of the menu bar, is the same in every application. It contains system commands and preferences.

The right side of the menu bar contains status menus. Status menus display information and provide shortcuts to system and application settings that you may frequently change. Common status menus include the volume slider, clock, and battery level indicator. You can show or hide individual status menus in System Preferences and other applications.

At the far right side of the menu bar is the Spotlight menu. You can use Spotlight, the advanced search technology built in to Mac OS X, to search your entire system for information contained in files, emails, contacts, images, calendars, and applications. For more information about Spotlight, see “Spotlight” on page 15.
Files and Folders
Most of the information in your computer is stored in files. Files include documents, images, applications, and so on. Folders are simply a collection of files. Each file or folder is represented by an icon with its name below or to the right of the icon. You can select the text in the file’s name to change it, and you can copy, move, and delete files on your computer.

Your computer comes with some folders already set up, but you can create and delete your own folders to organize your information. Most folders and files you create are stored in a home folder with your user account name. If you have multiple user accounts on your computer, each user account has its own home folder.

You click once on a file or folder icon to select it and twice to open it. Clicking twice quickly is called a “double-click.” If you double-click an application icon, you start the application and a window for the application opens. If you double-click a file created by an application, you automatically open the application (if it wasn’t open already) and open the file. For example, if you double-click a TextEdit file on the desktop, TextEdit starts up and its icon appears in the Dock. At the same time, the document opens on the desktop.

If you can’t use a mouse to select and click, you can use VoiceOver commands instead.

System Preferences
System Preferences is a Mac OS X utility that you use to customize your computer and choose essential settings such as your network configuration and Internet access. System Preferences is located in the Apple menu and has an icon in the Dock.

You can find settings to improve accessibility in these preferences:
• Displays preferences
• Keyboard & Mouse preferences
• Speech preferences
• Universal Access preferences

The easiest way to learn about the many options in System Preferences is to explore the different preference panes. Some preferences have multiple panes you access by clicking the tab buttons. Network preferences even has an Assistant button to help you troubleshoot connection problems.
Spotlight

Spotlight is extraordinarily useful for VoiceOver users. In many cases, it may be easier to use than the Finder for opening files, folders, and applications. When you type text in the Spotlight search text field, search results appear immediately in a menu below the search text field.

The more complete the word or phrase, the more refined your list of results will be. Search results are grouped by category, such as Applications, System Preferences, Documents, and Folders. You click an item in the list to open it.

If you don’t find the item you want, you can search again or click Show All at the top of the results list. Clicking Show All displays a more complete list of results in a new window called the Spotlight window.

Spotlight search results include all the metadata inside files, including the kind of content, the author, edit history, format, size, and many more details. Depending on the search word you type, you may find thousands of results. Spotlight narrows its results to show you the best matches, but you can also browse the entire list if you want.

You can use Spotlight to find just about anything, anywhere, on your computer with lightning speed. You don’t have to remember folder hierarchies or carefully store project files in meaningful folders.

You can find more information about Spotlight in Mac Help on your computer or on the Apple website at www.apple.com/macosx. See “Using Spotlight” on page 44 for information about using Spotlight with VoiceOver.
This chapter provides basic information about using VoiceOver with the Apple keyboard. You use your keyboard to control VoiceOver, so you need to be very familiar with your keyboard before you can use VoiceOver effectively.

If you are new to the Mac or have trouble using a keyboard, you’ll find important information in this chapter. If you use a portable computer, make sure you review the section in this chapter about function keys.

Important Keys to Know
You should be very familiar with the location of all the keys on your keyboard before you begin using VoiceOver. In addition to the letters and punctuation characters, you should know the location of these keys:

- Control
- Option
- Command
- Return
- Escape
- Home
- End
- Page Up
- Page Down
- Up, Down, Right, and Left arrows
- Function keys (F1 through F11)
If you're not familiar with the layout of keys on your keyboard, you can use the keyboard practice built in to VoiceOver to help you learn the name and location of the keys. In the keyboard practice, you press keys to hear their names.

**Using keyboard practice:**

1. Press Command-F5 to turn on VoiceOver.
   The Command keys are located directly to the left and right of the Space bar. You can press either one.
   The F5 key is in the top row of keys, sixth from the left.

2. Press Control-Option-K to begin keyboard practice.
   The Control and Option keys are the first two keys on the left of the bottom row. On a portable keyboard, the Fn key comes first, then Control and Option.

3. Press keys to hear their names. Press the Shift key to hear the shifted characters on punctuation keys.

4. Press the Escape key to end keyboard practice.
   The Escape key is on the top-left corner of the keyboard.

While you're using keyboard practice, you can't use your computer or keyboard for any other tasks. You must press the Escape key to return your keyboard to its regular use.

**About Function Keys**

In VoiceOver, you use the function keys at the top of the keyboard to perform many important actions. The function keys are labeled F1–F12 on some keyboards, and some keyboards have function keys up to F16.

You also use the function keys to perform actions and commands in many other software applications. To use a function key or other VoiceOver command keys for another software application when VoiceOver is on, press Control-Option-Tab and then press the function key. This command lets VoiceOver know that the next key combination is for another application.
Using Function Keys on Portable Computers

On a portable computer, many of the function keys are programmed to perform hardware-related functions such as adjusting brightness and volume. When you want to perform an alternate action for the key, you press the Fn key and the function key together. For example, in VoiceOver you press the following key combination to open VoiceOver Utility:

Control-Option-F8

If you use a portable computer, you must press the function key with the command Fn-Control-Option-F8

If you use VoiceOver all the time or very frequently, you can change the default behavior of the function keys so that they perform software actions. Then the portable keyboard behaves like a standard keyboard, and you press the Fn key only to change the volume or change any of the other hardware settings.

To change the default behavior of the function keys:
1 Click the System Preferences icon in the Dock or choose Apple menu > System Preferences to open System Preferences.
2 Click the Keyboard & Mouse button.
3 Click the Keyboard tab.
4 Select the checkbox labeled “Use the F1-F12 keys to control software features.”

When this checkbox is selected, you press the Fn key when you want to use the hardware function of the key, such as adjusting volume. When you use the keys for VoiceOver commands, you don’t need to press the Fn key with the VoiceOver commands that use function keys.

Using Home, End, Page Up, and Page Down on Portable Computers

A standard keyboard has dedicated keys for Home, End, Page Up, and Page Down. These are important VoiceOver navigation keys. On a portable computer, you use the arrow keys with the Fn key for these functions.

Keyboard Accessibility

If you are able to use a keyboard but find it difficult, some other features included in Mac OS X may help you use your keyboard more effectively with VoiceOver.

Sticky Keys

The Sticky Keys feature treats a series of modifier key presses as a single key combination. For example, you can press Control, and then Option, and your keyboard interprets that combination as Control-Option held down together.
To turn on Sticky Keys:
1 Click the System Preferences icon in the Dock or choose Apple menu > System Preferences to open System Preferences.
2 Click the Universal Access button.
3 Click the Keyboard tab.
4 Select the On radio button for Sticky Keys.

When you turn on Sticky Keys, you can also set options to hear a sound when a modifier key you press is accepted, and display an icon of the symbol for the modifier keys you pressed. Checkboxes for these options are below the Sticky Keys On and Off radio buttons.

**Slow Keys**
With the Slow Keys feature you can control the amount of time between when a key is pressed and when it is accepted by the keyboard. If you frequently press keys accidentally, you may want a longer delay.

To turn on Slow Keys:
1 Click the System Preferences icon in the Dock or choose Apple menu > System Preferences to open System Preferences.
2 Click the Universal Access button.
3 Click the Keyboard tab.
4 Select the On radio button for Slow Keys.
5 Move the Acceptance Delay slider to the left for a longer delay and to the right for a shorter delay.

You can also hear audible feedback when you press keys. You hear one sound when a key is pressed and a different sound when the key is accepted. This is a very good way to monitor what's happening if you can't see the screen. Select the checkbox labeled “Use click key sounds” under the Slow Keys On and Off buttons to turn this on.

**Key Repeat Rate**
If you find that keys register more than once when you press them, you can adjust the key repeat rate. The key repeat rate and key repeat delay let you control how fast keys repeat and adjust how much time the keyboard will wait before it begins to repeat a key press. If you have trouble releasing keys fast enough, you can set the delay very long or turn off the repeat.

To adjust the key repeat rate:
1 Click the System Preferences icon in the Dock or choose Apple menu > System Preferences to open System Preferences.
2 Click the Keyboard & Mouse button.
3 Click the Keyboard tab.

4 Move the Key Repeat Rate slider to the left if you want repeated keys to repeat slowly (if you tend to make mistakes when pressing keys, moving this slider to a slow setting will help minimize the number of repeated keystrokes). Move the slider to the right if you want the keys to repeat at a faster pace.

5 Move the Delay Until Repeat slider to the left to cause a longer delay between when you hold down the key and when the key begins to repeat.

You can move the Delay Until Repeat slider all the way to the left to turn off key repeating completely.

**Keyboard Settings in VoiceOver Utility**

You use the VoiceOver Utility application to customize VoiceOver settings. The Verbosity pane of VoiceOver Utility shown below includes some settings to help you use your keyboard.

![VoiceOver Utility Verbosity Pane](image)

**Typing Echo**

As you type, VoiceOver can speak what you typed. If you are not a confident typist, or if you just want to hear confirmation, you may want to use the typing echo. VoiceOver is set to echo each character as you type it. You can change the setting in the “While typing speak” pop-up menu to one of these:

- **None**: VoiceOver doesn’t speak what you type.
- **Every Character**: VoiceOver speaks each character as you type it. This is the default setting for VoiceOver.
- **Every Word**: VoiceOver speaks the word you type as soon as you press the Space bar, a punctuation key, or the Return key. This tells VoiceOver that the word is complete.
**Key Press Notification**

The "Announce when a modifier key is pressed" checkbox sets VoiceOver to say the name of the modifier key when you press it. VoiceOver speaks these keys:

- Shift
- Control
- Option
- Command
- Fn

Turning on this option may help you become accustomed to the location of modifier keys on your keyboard, and it may help prevent you from making mistakes.

**Caps Lock Key Notification**

If the Caps Lock key is pressed, you'll be unable to use many VoiceOver commands. Select the "Announce when the caps lock key is pressed" checkbox to hear VoiceOver announce when this key is pressed.

**To open VoiceOver Utility when VoiceOver is turned off:**

1. Click the System Preferences icon in the Dock or choose Apple menu > System Preferences to open System Preferences.
2. Click the Universal Access button.
3. Click the Seeing tab.
4. Click the Open VoiceOver Utility button.

When VoiceOver is turned on, you can open VoiceOver Utility with the VoiceOver command Control-Option-F8. You will find more information about other VoiceOver Utility settings in later chapters.
This chapter provides basic information about using VoiceOver to navigate your computer, click buttons, make selections in menus, and perform other basic tasks.

After reading this chapter, you will have enough information to begin using VoiceOver. You will have practiced moving the VoiceOver cursor, interacting with scroll bars, and navigating menus.

**Following Instructions**

When you use VoiceOver, you use the keyboard to activate controls. For example, when you read “click,” use the VoiceOver command Control-Option-Space bar instead of the mouse.

Menu commands are written using the greater than or right angle bracket symbol to show a sequence of menu commands. For example:

Choose Finder > Services > Summarize.

In this example, Finder is the name of a menu in the menu bar. Services is a submenu in the Finder menu, and Summarize is a command in the Services submenu. VoiceOver speaks the sequence as “Choose Finder greater than Services greater than Summarize.”

**Turning On VoiceOver**

You can turn VoiceOver on and off at any time; you don't have to restart your computer or log in again. This makes it easier for users with different needs to share the same computer.

You can turn on VoiceOver in System Preferences, and also with a quick VoiceOver command.
To turn on VoiceOver in System Preferences:
1 Click the System Preferences icon in the Dock or choose Apple menu > System Preferences to open System Preferences.
2 Click the Universal Access button.
3 Click the Seeing tab.
4 Select the On radio button for VoiceOver.

To turn VoiceOver on or off quickly:
- Press Command-F5. If you are using a portable computer, press Fn-Command-F5.
  If VoiceOver is on, Command-F5 turns it off. If VoiceOver is off, the command turns it on. The change takes effect immediately and remains in effect even after you log out of your user account or restart your computer.

Using VoiceOver in the Login Window
If your computer requires you to log in and you want to use VoiceOver to navigate and read the contents of the Mac OS X login window, you must first set a preference in Accounts preferences.

To turn on VoiceOver for the login window:
1 Click the System Preferences icon in the Dock or choose Apple menu > System Preferences to open System Preferences.
2 Click the Accounts button.
3 Click the Login Options button below the accounts list.
  If the Login Options button is dimmed, click the lock icon at the bottom of the Accounts window and type an administrator’s name and password to unlock the window.
4 Select the checkbox labeled “Use VoiceOver at login window.”

Pausing VoiceOver Speech
When you’re using VoiceOver, you may want to silence the speech when you don’t want to hear something. Just press and release the Control key to stop VoiceOver from speaking. If VoiceOver is reading text and you don’t use any other commands after you press the Control key, you can press and release Control again to hear VoiceOver resume speaking where it left off.

Controlling VoiceOver
To control VoiceOver, you press and hold the Control and Option keys while you press other keys to get information and perform actions.
When VoiceOver is on, a box is drawn around an object on the screen to show where VoiceOver is focused. This box is called the **VoiceOver cursor**. The visual representation of the VoiceOver cursor helps sighted users track VoiceOver's location. Objects in the VoiceOver cursor can be buttons and other controls, text, images, files, documents, and anything else that is displayed on your computer screen.

To move the VoiceOver cursor, you hold down the Control and Option keys as you press the arrow keys. This moves the VoiceOver cursor vertically or horizontally. In general, you should navigate windows horizontally, using the Left and Right arrow keys. The VoiceOver cursor moves from left to right, wrapping to the next row as it moves forward or back.

Use the Up and Down arrow keys to navigate vertically in lists and tables, or in windows where you are familiar with the layout. The VoiceOver cursor moves up and down, wrapping to the next column as it moves up or down.

For convenience, you can lock the Control and Option keys so that you don’t have to press them while you are controlling VoiceOver. Locking the Control and Option keys is useful if you are doing a lot of navigation and exploration with VoiceOver. It reduces the number of keys you need to press to accomplish these goals. With Control and Option locked, all you need to press are the remaining keys for the command, usually one or two others.

**To lock or unlock the Control and Option keys:**
- Press Control-Option-semicolon (;).

You can practice navigating with the VoiceOver cursor using the exercises at the end of this chapter.

**Reading Window Contents**

When you open a new window, the VoiceOver cursor goes to the first item in the upper-left corner of the window and stops there. As you navigate the window, you hear descriptions of the items in the VoiceOver cursor. If the VoiceOver cursor reaches text, it reads the text that’s visible on the screen.

A good way to get a sense of how a window is laid out or to find out what information the window contains is to have VoiceOver read all the contents of the window.

**To read the window contents:**
- Press Control-Option-Shift-W.
When you use the Control-Option-Shift-W command to read the contents of the window, VoiceOver reads only what’s visible. If there are more contents than can fit in the window, scroll bars appear at the bottom or right side of the window so that you can scroll to the rest of the content. For example, a large document may have many pages, but only part of one page is visible on the screen. You use scroll bars to make more of the document visible so that you can read it.

You can use other VoiceOver commands to read all the contents of scroll areas and other content areas without having to scroll. The next section describes these techniques.

**Reading Text**

Reading the contents of a window is very useful, but sometimes it isn’t enough. You’ll need to be able to read individual words, sentences, and characters as well. You can use the following VoiceOver commands for more control when you read text:

- Control-Option-C to read the last character in the VoiceOver cursor.
- Control-Option-W to read the last word in the VoiceOver cursor.
- Control-Option-S to read the sentence where the VoiceOver cursor is located.
- Control-Option-L to read the line where the VoiceOver cursor is located.
- Control-Option-P to read the paragraph where the VoiceOver cursor is located.

In addition, you can hear words or characters spelled phonetically to help you figure out something that is difficult to hear. To do this, you use the same commands for reading by character or reading by word, but you press the commands two or three times to hear progressively more detail.

For example, if you hear the word “tab” but aren’t sure you heard it right, you can press Control-Option-W to hear the word spoken. Press Control-Option-W again to hear the word spelled. If you’re still not sure what was read, press Control-Option-W a third time to hear each letter’s phonetic name (“tango alpha bravo”).

**Changing Rate, Pitch, and Volume Temporarily**

While you’re working, you may want to change the rate, pitch, or volume temporarily without changing your permanent settings. You can use a VoiceOver command to do this quickly.

To change settings temporarily:

1. Press Control-Option-Command-Right Arrow. Each time you press this command, you hear VoiceOver cycle through rate, pitch, and volume. If you stopped at “rate” the last time you used the command, the next time you press the command you hear “pitch.”
After you hear the setting you want to change, press Control-Option-Command-Up Arrow or Down Arrow. The Up Arrow increases the setting and the Down Arrow decreases the setting.

Release the keys to return to navigation.

These settings remain in effect until you change them, log out of your user account, turn off your computer, or turn off VoiceOver. To set your preferences for these, see “Customizing Voices” on page 54.

**Interacting With Content Areas**

To be successful using VoiceOver, you must understand the VoiceOver concept of interaction. When navigating the contents of windows, menus, and the desktop, VoiceOver groups related items in order to present a cleaner overall picture of the contents of the screen. So for example, moving once to the right will move the VoiceOver cursor from one button to another, not just from one word or character to the next. This allows you to quickly survey all that is available to you by navigating through the major elements of a window or application. When you find an item of interest, you then interact with it to read, add, control, or modify its contents.

Windows, documents, and webpages often have areas that contain text, files, or other content. When the VoiceOver cursor reaches one of these areas, it identifies the content area. Depending on the application or window, VoiceOver may identify these areas as:

- A scroll area
- HTML content
- A list
- A text area
- An outline
- A group
- A table

When you reach a content area, you can navigate past it to something else, or you can interact with the content area to investigate, read, or modify something it contains. For example, a Finder window has a sidebar that contains folders. You can skip over the sidebar to the view browser, or interact with the sidebar to select one of its folders.
First you use a command to let VoiceOver know that you want to interact with the items it contains. Then you use the VoiceOver navigation commands to navigate within the content area. The VoiceOver cursor stays within the boundaries of the object you’re interacting with, so when you navigate left, right, up, and down, you’ll navigate only to the objects within that area. If you find another object of interest, and it contains objects, you can interact with it as well. Interaction allows you to navigate the larger elements of an application quickly to locate what interests you, and also provides the control you need to investigate the smallest details.

When you’re done, a VoiceOver command stops the interaction, returning the VoiceOver cursor to the previous object or area. You can repeat the VoiceOver command to interact or stop interacting as many times as necessary. When there’s nothing more to interact with, or stop interacting with, you’ll hear a “beep” sound.

To interact with a content area:
- Press Control-Option-Shift-Down Arrow to begin interacting.
- Press Control-Option-Shift-Up Arrow to stop interacting with the content area.

To practice interacting with content areas, see the exercises at the end of this chapter.

You can use a VoiceOver command to read everything in the VoiceOver cursor, including content not visible on the screen. This is a quick way to find out what’s in a content area. When you use this command on an area that has scroll bars, the contents become visible as VoiceOver reads them.

To read everything in the VoiceOver cursor:
- Press Control-Option-A when the VoiceOver cursor is on a content area.

If you want to navigate or interact with the items in a content area, you have to first let VoiceOver know that you want to interact with the items it contains. Then you can use all the regular VoiceOver commands inside the content area.

Using Buttons and Controls
You can use VoiceOver commands to press a button, select checkboxes, choose an item in a list or menu, and move sliders.

For example, when instructions ask you to “click Save” or “click Cancel,” move the VoiceOver cursor to the button and use a VoiceOver command to perform the button’s action. You can use the same VoiceOver command to select a checkbox or radio button.

To click a button or select a checkbox or radio button:
- Press Control-Option-Space bar.

You use this same powerful command to select just about anything on the screen, from items in menus and lists to folders and files that you want to move or copy.
A slider control, such as the control for your computer’s volume, is usually identified as an incrementor or simply a slider. To move it, you have to first let VoiceOver know that you want to interact with the slider, just as you do for content areas. Then you use the arrow keys to change the value.

**To interact with a slider or incrementor:**
1. Press Control-Option-Shift-Down Arrow to start interacting.
2. Press Control and Option with an appropriate arrow key (Up, Down, Left, or Right, depending on whether the control is horizontal or vertical).
3. When you reach the value you want, press Control-Option-Shift-Up Arrow to stop interacting with the control.

**Learning More About an Item**
VoiceOver provides several ways to find out about an item that is in the VoiceOver cursor. If you aren’t sure what it is or how to use it, try any of the following discovery techniques:

- To hear a description of the item, press Control-Option-F3.
- To hear how to use the item, press Control-Option-H to hear the help tag. Help tags are often provided for controls so that you know what the control is used for.
- To hear a list of VoiceOver commands that can be used for the item, press Control-Option-H a second time to open the Commands menu. The Commands menu gives you every command you can use for the item.

**Navigating Menus**
Menus are vertical lists of commands and options that perform actions when you choose them. Some menu items have submenus that contain additional choices. You can think of menus and submenus as a hierarchical outline.

The menu bar at the top of the screen is separated into three main areas: the Apple and application menus, status menus, and the Spotlight menu. You can use the same VoiceOver command to access each of these areas.

**To navigate the menu bar:**
1. Press Control-Option-M to go to the first menu in the menu bar.
2. Press Control-Option-Right Arrow to move along the menu bar. You hear a “bonk” sound when you reach the last menu.
3. Press Control-Option-M again to move to the first status menu in the menu bar and Control-Option-Right Arrow to move to the last status menu.
4. Press Control-Option-M again to go to the Spotlight menu.
The Control-Option-M command cycles through the three areas. If you leave the menu bar, the next time you press the command, you start at the Apple menu.

Whether you’re in a Finder menu, application menu, pop-up menu, or VoiceOver menu, you use the same navigation techniques.

To navigate in a menu:
• Press Control-Option-Down Arrow to move down a menu.
• Press Control-Option-Up Arrow to move up a menu.
• Press Control-Option-Space bar to choose a menu item.
• Press Escape to leave a menu without making a selection.
• Press Control-Option-Right Arrow to move to the submenu and Control-Option-Left Arrow to move out of the submenu and back to the main menu.

You can use the exercises at the end of this chapter to practice navigating the menu bar and menus.

Navigating Quickly in a Menu
In Mac OS X, you can type the first letters of a word or phrase to move quickly to the item in the menu that most closely resembles what you typed. For example, if you know the menu contains a submenu for font selection, type “f” or “fo” to go to the first item in the menu that starts with these letters. The more letters you type, the greater the chance that the item you want will be found first.

In VoiceOver menus, the menu contracts to show only the items that contain the word, letters, or phrase you typed. If more than one item contains the letters you typed, you can use the arrow keys to locate the one you want. You can try this out in the Item Chooser menu exercise later in this chapter.

Using Pop-up Menus
Many windows and webpages use pop-up menus, described by VoiceOver as pop-up menu buttons, to present options and choices. Press Control-Option-Space bar to show the menu, then navigate the menu the same way you would any other menu.

Using Contextual Menus
Contextual menus give you quick access to often-used commands for the selected item. Contextual menus are convenient because you don’t have to navigate to the menu bar to perform an action. In Mac OS X, you press the Control key while you click the item with your mouse to see a contextual menu. You can perform the same action with a VoiceOver command.

To open a contextual menu for an item:
• Press Control-Option-Shift-M.

Contextual menus are also available for items in the Dock.
Understanding Duplicate Menu Items
Some menu items have an ellipsis (three dots) after the name. An ellipsis after an item in a menu lets you know that a dialog will appear when you choose that menu item. You'll need to take some type of action to dismiss the dialog and continue, such as typing a password or making a choice.

When VoiceOver is turned on, you will see or hear menu items that appear to be duplicates. The first menu item includes an ellipsis in the name and the second one doesn't. When VoiceOver is off, only the menu item with the ellipsis appears in the menu, and you would have to press Control when you choose the menu item to bypass the dialog and take action directly. When VoiceOver is on, you can choose either menu item.

For example, when VoiceOver is off, “Restart...” appears in the Apple menu, indicating that a dialog will appear when you choose this command. You can hold down the Option key when you choose this command and your computer restarts without displaying a dialog. When VoiceOver is on, you hear both “restart ellipsis” and “restart” in the menu.

Working With the VoiceOver Menu
The VoiceOver menu, shown below, appears as a shaded rectangle on the screen for sighted users.

The VoiceOver menu contains all the VoiceOver commands you can use for the item in the VoiceOver cursor followed by their command key equivalent. VoiceOver menus do not show the Control and Option keys for the commands, but you still must press Control and Option with the keys shown.

Sometimes VoiceOver commands require multiple key presses. For example, in the VoiceOver menu shown above, you press Control-Option-H two times to go directly to the Commands menu. In the VoiceOver menu, this is indicated by “H H.”
To open the VoiceOver menu:
- Press Control-Option-F7.

Sighted users can change the size of the font in the VoiceOver menu to make it easier to read. The font will stay the same size until you log out or restart your computer.

To change the size of the font:
- Press Control-Option-Right brace (}) to increase the font size and Control-Option-Left brace ({} to decrease it.

Note: The right and left brace keys are the shifted keys to the right of the P on your keyboard.

You can use the exercises at the end of this chapter to practice using the VoiceOver menu.

Using the Commands Menu
The Commands menu, shown below, is invaluable when you are learning VoiceOver. The Commands menu shows a list of all the VoiceOver commands you can use for the item in the VoiceOver cursor.

<table>
<thead>
<tr>
<th>Commands</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interact with text</td>
<td>⇧⇩</td>
</tr>
<tr>
<td>Item Chooser</td>
<td>l</td>
</tr>
<tr>
<td>Click mouse</td>
<td>⇧ space</td>
</tr>
<tr>
<td>Echo VoiceOver cursor contents</td>
<td>A</td>
</tr>
<tr>
<td>Echo system dialog contents</td>
<td>⇧W</td>
</tr>
<tr>
<td>Bring system dialog to front</td>
<td>⇧F2</td>
</tr>
<tr>
<td>Move system dialog</td>
<td>`</td>
</tr>
<tr>
<td>Resize system dialog</td>
<td>~</td>
</tr>
<tr>
<td>Ignore next keypress</td>
<td>tab</td>
</tr>
</tbody>
</table>

To open the Commands menu:
- Press Control-Option-H twice.

The first time you press the command, you hear the contents of the item’s help tag, if there is one. The second time, the Commands menu opens.
Chapter 4 Exercises
The exercises that follow will help you practice moving the VoiceOver cursor, interacting with scroll areas, and navigating menus.

Exercise 4.1: Moving the VoiceOver Cursor
In this exercise, you will practice moving the VoiceOver cursor and listening to the audible cues and descriptions.
1. Press Command-F5 to turn on VoiceOver.
2. Press and hold the Control and Option keys while you press the Up, Down, Left, and Right arrow keys.
3. Listen to the descriptions of items and practice moving around the screen.
4. Listen to the sound effects that indicate wrapping to the next or previous line or column.

Exercise 4.2: Interacting With a Content Area
In this exercise, you’ll move the VoiceOver cursor to a content area and interact with it.
1. Press Command-F5 to turn on VoiceOver.
2. Press Command-N to open a new Finder window. (Make sure the Finder is the active application.)
3. Press and hold the Control and Option keys while you press the Right Arrow keys. Listen to the descriptions of items and stop when you hear “sidebar list.”
4. Press Control-Option-Shift-Down Arrow and listen to VoiceOver say “Interact with sidebar list Network folder.” If you have something other than a Network folder at the top of the list, or if an item is selected, you’ll hear that instead.
5. Press Control-Option-Down Arrow to move down the list. Notice the tone that indicates you’ve reached the end of the list.
6. Press Control-Option-Shift-Up Arrow to stop interacting with the list. Listen to VoiceOver say “Stop interacting with sidebar list.”

Exercise 4.3: Navigating the Menu Bar
In this exercise, you will use VoiceOver commands to access the different parts of the menu bar. The VoiceOver command Control-Option-M moves the VoiceOver cursor to the next section of the menu bar each time you press it.
1. Make sure the Finder is the active application by either clicking the desktop or pressing Control-Option-Shift-D to move the VoiceOver cursor to the desktop.
2. Press Control-Option-M to go to the menu bar, then press Control-Option-Right Arrow to move along the menu bar. Listen to the names of the different menus. When you get to the last menu, you hear a sound effect.
3. Press Control-Option-M again. You hear the first status menu, which may be “volume” if you haven’t turned on any applications that have status menus.
4. Press Control-Option-Right Arrow to move to all the status menus. You hear a sound to indicate the end of the status menus.

5. Press Control-Option-M again to access the Spotlight menu. You can type a search word or term here to find items on your computer.

6. Press Escape to close the menu without making a selection.

**Exercise 4.4: Navigating in a Menu and Submenu**

In this exercise, you will go to the menu bar and use a submenu to find any applications, documents, and servers you used recently.

1. Press Control-Option-M to go to the Apple menu, which is the first menu in the menu bar.

2. Press Control-Option-Down Arrow to open the Apple menu.

3. Press Control-Option-Down Arrow until you hear “Recent Items submenu.”

4. Press Control-Option-Right Arrow to go to the submenu.

5. Press Control-Option-Down Arrow and Control-Option-Up Arrow to move up and down the menu to hear the applications, documents, and servers you used recently.

6. Press Control-Option-Left Arrow to return to Recent Items in the Apple menu.

7. Press Escape to leave the menu without making a selection.

**Exercise 4.5: Using the VoiceOver Menu**

In this exercise, you will open the VoiceOver menu and use VoiceOver commands to increase the font size, navigate the menu, and select an item in the menu.

1. Press Control-Option-F7.

2. Press Control-Option-right brace (} ) several times to make the font bigger.

3. Press Control-Option-left brace ({ ) until the font size is back to its original size or any size you wish.


5. Press Control-Option-Right Arrow to enter the Commands menu, then use the Up and Down arrow keys to read the items in the menu.

6. Press Control-Option-Left Arrow to return to the VoiceOver menu.

7. Press Control-Option-Up Arrow until you hear “Help question mark,” then press Control-Option-Space bar to select it.

The VoiceOver menu closes and the command you chose is performed. In this case, the VoiceOver menu closes and VoiceOver Help opens.
You can use VoiceOver to read text, navigate your computer, and perform your daily tasks.

When you know the basics of Mac OS X and VoiceOver navigation (covered in earlier chapters), you can begin to use VoiceOver to access files, read documents, and manage your computer. This chapter teaches you how to apply what you know about VoiceOver to these everyday tasks.

Using the Dock
As you learned in Chapter 2, “Introduction to Mac OS X,” the Dock contains icons for applications and documents that you access frequently, or that you are currently working with. When you hear the name of the application or document you want to use, click it to open it on the desktop.

To open an item from the Dock:
1. Press Control-Option-D to move the VoiceOver cursor to the Dock.
2. Press Control-Option-Right Arrow to move across the Dock if it is on the bottom of the screen and Control-Option-Down Arrow if it is located on one side.
3. Press Control-Option-Space bar to open an item in the Dock.

The Dock can be positioned on the bottom, left, or right side of the screen. You don’t need to know where the Dock is located to navigate it. The Down and Right arrow keys move toward the bottom or right of the Dock, and the Up and Left arrow keys move up or to the left. The arrow keys work the same, regardless of the location of the Dock.

If it will help you to know the location of the Dock, you can find out by checking the Dock menu.

To find out where the Dock is positioned on the screen:
1. Press Control-Option-M to go to the Apple menu.
2. Press Control-Option-Down Arrow to move down the menu until you hear “Dock menu,” then press Control-Option-Right Arrow.
3 Press Control-Option-Down Arrow to move down the Dock menu until you hear the location of the Dock. For example, “Position on bottom checked.”

**Setting Dock Preferences**

You can also use the Dock submenu to set some preferences for the Dock and quickly access the Dock preferences pane of System Preferences.

When hiding is turned on in the Dock submenu, the Dock disappears from the desktop. Dragging the mouse pointer to where the Dock appears when it’s visible causes it to pop up and remain visible as you move the mouse along it. With VoiceOver, you just have to press the VoiceOver command for the Dock to make the Dock visible.

**Working With Contextual Menus for Dock Items**

Every item in the Dock has a contextual menu. For example, you can remove an icon from the Dock or permanently add one for an application whose icon would normally appear in the Dock only when that application was open. The items in the contextual menu vary, depending on the type of item.

**To open a contextual menu for an item in the Dock:**

- Press Control-Option-Shift-M when the VoiceOver cursor is on the item.

  Use the standard menu navigation techniques to navigate and select items from a contextual menu. If you want to close the menu without making a selection, press the Escape key.

You can practice using the Dock in the exercise at the end of this chapter.

**Switching Between Applications and Windows**

Most people have more than one application open at a time and often one or more windows open for each application. You can use a standard Mac OS X keyboard to quickly switch between open applications.

**To switch between open applications:**

1 Press and hold down the Command and Tab keys.

2 Continue to hold down the Command key while you press and release the Tab key. Each time you press the Tab key, you hear the next application.

3 When you hear the application you want to switch to, release both keys.

You can use the Application Chooser menu and the Window Chooser menu in VoiceOver to switch quickly to the application and window you want to use.
The Application Chooser menu, shown below, lets you choose both an application and an open window for the selected application.

![Application Chooser](image1)

**To use the Application Chooser menu:**
1. Press Control-Option-F1. You hear the name of the active application and the number of open applications.
2. Press Control-Option-F1 a second time to open the Application Chooser menu.
3. Press Control-Option-Down Arrow to move down the list of open applications.
4. When you hear the application you want to switch to, press Control-Option-Right Arrow to go to the submenu for that application.
5. Press Control-Option-Down Arrow until you reach the window you want. If any applications have a dialog open, they also appear in the menu.
6. Press Control-Option-Space bar to move the VoiceOver cursor to the window or dialog that you want. If you just want to switch to the application without going to a specific window, choose the first item in the submenu. If no windows are open for the application, this will be the only choice in the menu.

The Window Chooser menu, shown below, works the same way as the Application Chooser menu. However, the Window Chooser menu identifies only the open windows for the active application.

![Window Chooser](image2)
To use the Window Chooser menu:
1 Press Control-Option-F2. You hear the name of the window that is active.
2 Press Control-Option-F2 a second time to open the menu.
3 Press Control-Option-Down Arrow to move down the list of open windows for the active application. If the application has a dialog open, it also appears in the menu.
4 When you hear the window or dialog you want, press Control-Option-Space bar to move the VoiceOver cursor there.

Navigating Finder Windows
When you open a Finder window, the VoiceOver cursor is in the toolbar, focused on the Back button. You can find a detailed description of the Finder window in “The Finder” on page 12. When you use the Finder window to locate and open a file or folder, you first find the top level folder in the sidebar. When a folder is selected in the sidebar, its contents are displayed on the right side of the Finder window in the view browser. Finder windows can display items in the view browser in icon, list, or column view.

Use the navigation method described here to navigate to the view browser. Then use the method under the view descriptions to navigate a particular view.

To navigate the Finder window:
1 Press Control-Option-Right Arrow to move the VoiceOver cursor across the toolbar. When you pass over the view buttons, listen to see which view button is selected. If you know which view you want to use, press Control-Option-Space bar to select it.
2 Press Control-Option-Right Arrow until you hear “sidebar.”
3 Press Control-Option-Shift-Down Arrow to interact with the contents of the sidebar.
4 Press control-Option-Down Arrow to move down the list of items in the sidebar. When you find the folder you want, press Control-Option-Shift-Up Arrow to stop interacting.
5 Press Control-Option-Right Arrow to move to the right column, the view browser.

When you reach the view browser, you use different techniques to navigate its contents, depending on which view is being used. Below are the descriptions of each view and the navigation techniques for each. You will quickly discover the ones that work best for you.
Using Icon View

In icon view, shown below, each item in the view browser is represented by an icon. Icons are usually organized alphabetically in rows.

You can use the arrow keys to navigate along the rows, or type the beginning letters of a file to jump to an item quickly.

**To open a file in icon view:**
1. If the view browser is not in icon view, you can press the Finder keyboard shortcut Command-1 to change it now.
2. Press Control-Option-Shift-Down Arrow to interact with the browser contents.
3. Type the first few letters of the name of the item you want to locate. The VoiceOver cursor moves to the first file that starts with the letters you typed. You may have to use the arrow keys to move from there to the exact file you want to open.
4. Press Command-O to open the file.

Using List View

In list view, shown below, items are listed alphabetically and information about each item appears next to it on the same row.
A disclosure triangle appears to the left of folders. When you click a disclosure triangle, you see the contents of the folder below it, indented as they would appear in an outline.

**To open a file in list view:**
1. If the view browser is not in list view, you can press the Finder keyboard shortcut Command-2 to change it.
2. Press Control-Option-Shift-Down Arrow to interact with the browser contents.
3. Press Control-Option-Down Arrow to move down the line of contents. You hear the name of the item and all the information in the row.
4. Press Command-O to open the item selected.

**Sorting Items in List View**
Because list view is also a table, you can press Control-Option-Right Arrow or Left Arrow to navigate to individual cells in the table. Then you can sort the information by column. For example, you can arrange the items by the date they were modified.

**To sort items by column in list view:**
1. Move the VoiceOver cursor to the first row of information and press Control-Option-Right Arrow to move to the column you want to sort by.
2. Press Control-Option-Vertical line (|) to sort the column. The vertical line is the shifted character on the right edge of the keyboard above the Return key.
3. To change the order of the sort, press Control-Option-Vertical line (|) again. For example, you could sort the Date Modified column to show the most recent changes at the top or at the bottom of the column.

**Using Column View**
In column view, shown below, items are shown in a series of columns like a horizontal outline.
Column view is very useful for browsing nested folders. When you select a folder, its contents are shown in the column on the right. You keep moving right until you reach the file you want to open. Your browsing is confined to one window so that you can easily retrace your path if you need to.

To open a file in column view:
1. If the view browser is not in column view, you can press the Finder keyboard shortcut Command-3 to change it.
2. Press Control-Option-Shift-Down Arrow to interact with the browser contents.
3. Press Control-Option-Down Arrow to move to the item you want to open. If it’s a single file, press Command-O to open it. If it’s a folder, continue with the next step.
4. Press Control-Option-Right Arrow to move to the contents of the next folder.

**Accessing Finder Window Buttons**
You use the three round buttons in the upper-left corner of a Finder window to close the window, put the window in the Dock, or resize the window to its former size. You can press these buttons with a mouse, or use these Finder shortcuts:
- Command-W to close the window
- Command-M to minimize the window, placing it in the Dock for convenient access later

To resize the window, you can either press Control-Option-M to access the menu bar and then choose Window > Zoom, or use the VoiceOver commands for window resizing described in “Moving and Resizing Windows” on page 43.

**Selecting Files and Folders**
In the Finder and in other applications, you must first select a file or folder that you want to use before you can open it or copy it. There are different ways to select files and folders, depending on whether cursor tracking is turned on or off. Cursor tracking is described in more detail in Chapter 9.

When cursor tracking is on, moving the VoiceOver cursor to a file or folder automatically selects it. If you haven’t changed cursor tracking settings in VoiceOver Utility, cursor tracking is already turned on.

If you’re not sure what is selected, you can use a VoiceOver command to find out. This is important information to know before you perform an action such as copying or deleting a file.

**To hear what is selected:**
- Press Control-Option-F6.
If nothing is selected, you hear “no selection available.” If text is selected, you hear the text as it is read.

If you have cursor tracking turned off, the keyboard focus and VoiceOver cursor will probably be in different locations. This means that the item in the VoiceOver cursor is not selected automatically. You must use a VoiceOver command to select it.

To select an item when cursor tracking is turned off:
- Press Control-Option-Command-F4.

You can select more than one item at a time. This is useful when you want to perform the same action for all of the selected items. For example, you may want to delete several documents with one command. Selecting multiple items works only when cursor tracking is turned off.

To select multiple items:
1. Press Control-Option-Shift-F3 to turn off cursor tracking.
   *Note:* You can press this command again to turn cursor tracking back on when you’re finished selecting.
2. Press the Escape key to deselect anything that is already selected.
3. Move the VoiceOver cursor to the first item you want to select and press Control-Option-Command-Space bar.
4. Move to the next item and press Control-Option-Command-Space bar. Continue until all the items you want are selected.

If you want to deselect an item you selected, return to it and press Control-Option-Command Space bar.

You use different techniques to select text. For more information about selecting text, see “Selecting Text” on page 74.

**Copying and Moving Files**

If you can use a mouse, you can drag files to move them, and even hold down the Option key while you drag to create a copy of the original file in another location. If you cannot use a mouse, you can still use VoiceOver to copy a file and paste it in a new location. You can delete the original if you want to.

To copy and move files using VoiceOver:
1. Navigate to the file you want to copy.
2. Press Command-C to copy the file.
3. Navigate to the location where you want to place the copy.
4. Press Command-V to paste it in the new location.
Note: If you have cursor tracking turned off, press Control-Option-Command-F4 to select the item so you can copy it.

The Item Chooser Menu
Using the arrow keys to move across every item in a window can be very tedious, especially if you have an idea of what you are looking for and want to get to it quickly. A convenient alternative is to use the Item Chooser menu, shown below.

The Item Chooser menu displays these types of items and more:

- Controls
- Text in table cells
- Static text
- Buttons

In a Mail window, for example, you see all the buttons in the Mail window, names of message senders, column headers, message subjects, and more.

To open the Item Chooser menu:
- Press Control-Option-I.

You can type some letters to quickly reduce the number of items in the menu and use all the other menu navigation and selection techniques you've learned.
Interacting With Windows
As you work, you will probably have multiple application windows open on the
desktop. You can drag these windows to different locations or resize them by dragging
the bottom-right corner of the window. VoiceOver users who can't see the screen or
use a mouse can do this too.

Moving and Resizing Windows
You can use the accent and tilde keys to move or resize a window with VoiceOver. The
accent key is directly above the Tab key, and the tilde is the accent key shifted.

To move a window:
1 Press Control-Option-accent (') to begin moving a window.
2 Use the arrow keys to move the window up, down, left, and right.
3 Press Escape to stop interacting with the window.

You hear a “bonk” sound when you can’t move a window any farther in one direction.
You can use the Shift key to move a window in smaller increments.

To resize a window:
1 Press Control-Option-tilde (~) to begin resizing a window.
2 Use the arrow keys to make the window taller, shorter, wider, or narrower.
3 Press Escape to stop interacting with the window.

While you're moving or resizing a window, you can’t use VoiceOver to perform any
other actions. Pressing Escape lets VoiceOver know you’re done.

Moving a Scroll Bar
Previous chapters discussed how to read the content in scroll areas so that all the
contents are read and the window scrolls automatically. There may be times when you
want to scroll manually as well.

To move a scroll bar:
1 Press Control-Option-Shift-Down Arrow to begin interacting with the scroll area.
2 Press Control-Option-Shift-S to begin scrolling.
3 Press Control and Option with the arrow keys to scroll up and down, or left and right.
When the window can’t be scrolled any farther in a particular direction, you hear a
“bonk” sound.
4 Press the Escape key to leave the scrolling mode.
Using Spotlight

The fastest and easiest way to find something on your computer is to type a search term in the Spotlight menu and then click the item you want in the search results. It takes just seconds and will save you a lot of time.

There is almost no limit to the type of information you can find with Spotlight. In Spotlight preferences, you can specify categories of information you want Spotlight to search. For example, you can limit searches to just applications, documents, folders, and Mail messages. Or you can expand your search options to include bookmarks in Safari, image files, and more.

You can use Mac OS X keyboard shortcuts or the VoiceOver menu command to start a Spotlight search.

Using the Spotlight Menu

To find an item on your computer, open the Spotlight search field, and type your search term. You can open the Spotlight menu in two ways:

- Press Command-Space bar.
- Press Control-Option-M three times.

As soon as you type the first letters, the search results appear below the search field and begins to display the results. When the search is finished, you hear VoiceOver announce the number of items found.
To navigate the Spotlight menu:
1 Press Command-Space bar or Control-Option-M three times to open the Spotlight menu.
2 Type the word or term you want to use for your search.
3 Press Control-Option-Down Arrow to move down the list of search results. Results are categorized by type.
4 Press Control-Option-Space bar when you hear the item you want to open.

The item you selected opens immediately and the VoiceOver cursor leaves the Spotlight menu and goes to the item you opened.

If you don’t see the item you want, you can go back to the top of the list and select Show All to open the Spotlight window.

Using the Spotlight Window
The Spotlight window, shown below, provides additional information about each item and contains a sidebar on the right where you can sort items in each group.

You can open the Spotlight window in two ways:
• Press Command-Option-Space bar.
• Click Show All at the top of the Spotlight search results window.
When you interact with the scroll area that contains the search results, the VoiceOver cursor starts on the first column, which contains the disclosure triangles for each group. The way you interact with disclosure triangles in the Spotlight window is different than how you interact with disclosure triangles in some other windows.

To open or close disclosure triangles in the Spotlight window:

- Press Control-Option-Space bar.

As you navigate the search results, press Control-Option-Down Arrow to move down a column. Spotlight displays the first five results in each group. If there are more than five results, you can click the link at the bottom of the group that tells you how many more items it found.

Changing the Sort Criteria

The body of the Spotlight window contains a sidebar: a scroll area within a scroll area, which you use to sort results. You can sort groups by kind, date, or people, or you can show a flat list. Within groups, you can sort by name, date, kind, or people. You can also choose different ways to sort by date and location.

To change the sorting criteria:

1. Press Control-Option-Right Arrow until you hear “scroll area.” This is the area that contains the search results.
2. Press Control-Option-Shift-Down Arrow to interact with the contents.
3. Press Control-Option-Right Arrow to move across the first row in the table until you hear “scroll area” again. This is the sorting sidebar. Press Control-Option-Shift-Down Arrow to interact with it.
4. Press Control-Option-Down Arrow until you hear the criteria you want to use. For example, you can sort groups by kind, date, people, or flat list.
5. Press Control-Option-Command-F5 to move the mouse pointer to the VoiceOver cursor.
6. Press Control-Option-Shift-Space bar to click the mouse. The search results on the left immediately change to reflect your choice.

Chapter 5 Exercises

The exercises that follow will help you practice using the Dock and the Item Chooser menu, and copying and pasting a folder in different Finder views.

Exercise 5.1: Using the Dock

In this exercise, you will open a contextual menu for an item in the Dock and move an icon to a different location in the Dock. Rearranging icons in the Dock lets you place frequently used applications where it’s easiest for you to access them.

1. Press Control-Option-D to open the Dock.
2 Press Control-Option-Right Arrow and then Control-Option-Left Arrow to move along the Dock in either direction. Try using the Up and Down arrows too. Stop when you reach an icon you would like to use for this exercise.

Notice that VoiceOver identifies open applications by announcing the name of the application and then "running."

3 Press Control-Option-Shift-M to open the contextual menu for the icon.

4 Press Control-Option-Up Arrow or Down Arrow to navigate the menu. Notice the types of commands you can access from the contextual menu.

5 Press Escape to close the menu without making a selection.

6 Press Control-Option-D again to move the VoiceOver cursor to the Dock, then move the VoiceOver cursor to an icon you want to move.

7 Press Option with an arrow key to move the icon. Each time you press the arrow key, the icon moves in the direction of the arrow.

8 Press Control and Option with the arrow keys to hear the new location of the icon.

Try this exercise again and listen to the contextual menu for an application that is running. If you have windows or documents open for the application, you can access them from the contextual menu.

**Exercise 5.2: Using the Item Chooser Menu**

In this exercise, you will open a window, use the Item Chooser menu, and find an item in the menu.

1 Click the desktop to make the Finder active, or press Control-Option-Shift-D to go to the desktop.

2 Press Command-N to open a new Finder window.

3 Press Control-Option-I to open the Item Chooser menu.

4 Press Control-Option-Down Arrow to move down the menu and hear the type of items it contains.

5 Type *documents* or just *doc* to go to the Documents Folder. The Item Chooser menu is filtered to show only those items that contain the letters or word you typed.

6 Press Control-Option-Down Arrow until you hear Documents Folder, then press Control-Option-Space bar to select it.

The Item Chooser menu closes and the VoiceOver cursor moves to the Documents Folder in the Finder window.

**Exercise 5.3: Copying and Pasting a File**

In this exercise, you will navigate the Finder window to locate a file, then copy and paste it to a new location. After you copy a file or folder, you can move the copy to any location on your computer and paste it there.
This exercise is presented three times, one for each of the different Finder views. All of the Finder exercises begin with a new Finder window. To open a Finder window, you can do one of the following:

- Go to the Dock and navigate to the Finder icon. Then press Control-Option-Space bar to go to a Finder window.
- Press Command-N when the Finder is the active application.
- Press Control-Option-F1 twice to open the Application Chooser menu. Choose “Finder menu” and then “Go to Finder.”

The view browser changes automatically to icon view, list view, and column view, depending on the item you select in the sidebar. You can use the Finder keyboard shortcuts provided in each exercise to switch to the view you want to use.

**Exercise 5.3.a: Copying and Pasting in Icon View**

1. Open a Finder window.
2. Press Control-Option-Right Arrow until you hear “sidebar list.”
3. Press Control-Option-Shift-Down Arrow to interact with the contents of the sidebar.
4. Press Control-Option-Down Arrow until you hear your home folder. The title of your home folder includes your user name.
5. Press Control-Option-Shift-Up Arrow to stop interacting with the sidebar.
6. Press Control-Option-Right Arrow until you hear “icon view scroll area.” The contents of the right frame may be in a different view, depending on what you select in the sidebar. You can press Command-1 to switch to icon view.
7. Press Control-Option-Shift-Down Arrow to interact with the contents.
8. Press Control-Option-Right Arrow until you hear “Sites selected folder.”
9. Press Command-C, the Finder keyboard shortcut for copying.
10. Press Command-V, the Finder keyboard shortcut for pasting.
11. Press Control-Option-Right Arrow until you hear “Sites copy selected folder.” This is the copy you just made and pasted to the same folder.
12. Press Command-Delete, the Finder keyboard shortcut for deleting, to delete the copy you just made. If you want to verify that the correct folder is selected before you delete it, press Control-Option-F6 to hear the selected item.

**Exercise 5.3.b: Copying and Pasting in List View**

1. Open a Finder window.
2. Press Control-Option-Right Arrow until you hear “sidebar list.”
3. Press Control-Option-Shift-Down Arrow to interact with the contents of the sidebar.
4. Press Control-Option-Down Arrow until you hear your home folder. The title of your home folder includes your user name.
5 Press Control-Option-Shift-Up Arrow to stop interacting with the sidebar.

6 Press control-Option-Right Arrow until you hear “outline.”

   The contents of the right frame may be in a different view, depending on what you
   select in the sidebar. You can press Command-2 to switch to list view.

7 Press Control-Option-Shift-Down Arrow to interact with the contents.

8 Press Control-Option-Down Arrow until you hear “Sites selected folder.”

9 Press Command-C, the Finder keyboard shortcut for copying.

10 Press Control-Option-Down Arrow, then press Command-V, the Finder keyboard
    shortcut for pasting. In list view, you need to move away from the folder you just
    copied or you will suddenly find yourself using Spotlight to search your computer for
    documents.

11 Press Control-Option-Right Arrow or Left Arrow until you hear “Sites copy selected
    folder.” This is the copy you just made and pasted to the same folder.

12 Press Command-Delete, the Finder keyboard shortcut for deleting, to delete the copy
    you just made. If you want to verify that the correct folder is selected before you delete
    it, press Control-Option-F6 to hear the selected item.

**Exercise 5.3.c: Copying and Pasting in Column View**

1 Open a Finder window.

2 Press Control-Option-Right Arrow until you hear “sidebar list.”

3 Press Control-Option-Shift-Down Arrow to interact with the contents of the sidebar.

4 Press Control-Option-Down Arrow until you hear the name of your home folder. The
    title of your home folder includes your user name.

5 Press Control-Option-Shift-Up Arrow to stop interacting with the sidebar.

6 Press Control-Option-Right Arrow until you hear “column view browser.”

   The contents of the right frame may be in a different view, depending on what you
   select in the sidebar. You can press Command-3 to switch to column view.

7 Press Control-Option-Shift-Down Arrow to interact with the contents of the scroll area.

8 Press Control-Option-Shift-Right Arrow until you hear “Sites selected folder.”

9 Press Command-C, the Finder keyboard shortcut for copying.

10 Press Command-V, the Finder keyboard shortcut for pasting.

11 Press Control-Option-Right Arrow until you hear “Sites copy selected folder.” This is the
    copy you just made and pasted to the same folder.

12 Press Command-Delete, the Finder keyboard shortcut for deleting, to delete the copy
    you just made. If you want to verify that the correct folder is selected before you delete
    it, press Control-Option-F6 to hear the selected item.
This chapter provides information about the many ways you can customize VoiceOver for your needs. It also introduces VoiceOver Utility, the application you use to customize your VoiceOver settings.

VoiceOver Utility is located in Applications/Utilities. You can open it by clicking the VoiceOver Utility button in Universal Access preferences, or by using the VoiceOver command Control-Option-F8.

**Important:** When you press the Reset button in VoiceOver Utility, all the settings on all the panes except Pronunciation are restored to the way they were the first time you turned on VoiceOver. You can’t reset only the settings on a single pane.

**Saving VoiceOver Settings**

When you have your VoiceOver settings just the way you want them in VoiceOver Utility, you might want to save them so that you can use those same settings when you use another computer or so that you can share them with a friend. If you have a removable storage device or a server where you can store your settings file, sharing your settings is easy to do.

**To save your VoiceOver settings to a file:**

1. Press Control-Option-F8 to open VoiceOver Utility.
2. Choose File > Export Configuration or press Shift-Command-E.
3. In the Save dialog that opens, type a name for the file and choose where you want to save it, then click Save.

You can use the same process to import the saved file. Choose File > Import Configuration or press Shift-Command-I. Then choose your saved configuration file and click Save. You don’t have to restart VoiceOver or your computer, the changes take effect immediately.
Setting the Amount of Spoken Detail
When you start using VoiceOver, you may want to hear as much detail as possible to help you learn about your computer and applications. As you become more familiar with these, you may not need to hear as much detail. You can choose these and other settings on the Verbosity pane of VoiceOver Utility, shown below.

Adjusting Punctuation Settings
Punctuation includes the common punctuation marks as well as symbols. You can adjust what you want to hear when punctuation occurs in documents. VoiceOver includes these levels:

- **None** speaks text as you would normally read it, pausing for commas and periods.
- **Some** speaks keyboard symbols and many math symbols, such as the plus sign (+).
- **Most** speaks all special symbols but doesn’t speak common punctuation, such as the comma and period.
- **All** speaks all special symbols and punctuation except for spaces. So, you might hear a sentence spoken like this: “She stopped and turned comma before speaking period.”

Some documents, websites, and email messages may have repeated punctuation characters used as emphasis or design elements. You can decide whether or not you hear such punctuation. Of course, if you set your punctuation to None, you won’t hear any. The Repeated Punctuation options are:

- **Always Spoken** means that you hear all punctuation exactly as it occurs unless you’ve set a punctuation level that skips certain punctuation or symbols.
- **First Three Times** means that you hear only the first three instances of a punctuation symbol.
• *Spoken With Count* means that you hear the number of instances of the punctuation and then the name of the symbol. For example, the sentence “I am overjoyed!!!!!!!” might be read as “I am overjoyed eight exclamation mark” when Punctuation is set to All.

**Adjusting Text Attribute Settings**

Writers and designers of documentation and websites use punctuation size and style to convey meaning or to separate elements. VoiceOver can let you know when text changes occur, which can greatly improve your comprehension of the material. You can set whether and how you want VoiceOver to alert you to text changes by choosing one of these settings for the “When text attributes change” pop-up menu:

• *Do Nothing* sets VoiceOver to ignore changes in text attributes when reading text.

• *Play Tone* sounds a light tone when you encounter text in a different font or style than what VoiceOver was just reading.

• *Speak Attributes* speaks the text attributes at the beginning of the text with different attributes. For example, “bold 15 point” or “12 point Helvetica.” You hear only the differences from the previous text, so if both sentences use the same font, you hear only the size or style difference.

**Setting Navigation Options**

The Navigation pane of VoiceOver Utility, shown below, provides settings for how the VoiceOver cursor navigates websites and for using the VoiceOver cursor in conjunction with the keyboard and mouse, together or separately.
Setting Website Navigation Options
The VoiceOver cursor typically moves linearly across webpages, from upper left to lower right. Depending on how a webpage was designed, the VoiceOver cursor may seem to move randomly when you navigate in this way. VoiceOver provides some options for improving the navigation experience.

“Group items in web pages” organizes a webpage into related groups of information. For example, all the song titles in a list of hot tunes, or an image with an excerpt of a news article. When you choose this option, VoiceOver identifies these as a group. You can skim quickly through groups until you hear one that interests you. Each group of information is treated as a content area, so you use the VoiceOver command Control-Option-Shift-Down Arrow to interact with the contents.

When you click a link on a webpage, a new webpage opens and the VoiceOver cursor goes to the top of the HTML content area. You don’t have to interact with it to read the contents. However, when you type an address in the address field and press Return, the VoiceOver cursor stays in the address field of the newly loaded page. If you want it to start in the HTML content area on a new webpage, select the “VoiceOver cursor moves to newly loaded web page” checkbox.

Images with no descriptions can slow down navigation and aren’t helpful if you can’t see them. You can choose options in VoiceOver to skip images, or to skip images without a description. You should be aware, though, that sometimes images are actually links, so if you avoid them completely, you could be missing something important on a webpage.

For more information about using VoiceOver with Safari to surf the Internet, see “Using the Safari Web Browser” on page 68.

Setting VoiceOver Cursor Options
When you use the mouse, you click an item to select it. You can also use the Tab key to move keyboard focus to some items to select them, including items in the view browser of the Finder window. VoiceOver links the keyboard focus and the VoiceOver cursor together to simplify navigation for VoiceOver users. This is called cursor tracking.

You can customize how you use the VoiceOver cursor in conjunction with the keyboard and the mouse. You might find it convenient to keep them together as a single unit, or use them separately. Either way, VoiceOver Utility provides options you can set to fit with your specific working style.
You can choose any combination of tracking options shown on the Navigation pane of VoiceOver Utility. The text selection tracking settings apply when you are interacting with text in a document. When you edit or create documents or enter text in a text box, you are interacting with text. Experiment to see which combination works best for you.

For more information about using the VoiceOver cursor, mouse, and keyboard independently, see “Advanced Cursor Tracking” on page 79.

Customizing Voices
VoiceOver includes a variety of voices so that you can choose the ones that work best for you. Several companies also offer additional voices, available separately, that work with VoiceOver. You can use the Voices pane of VoiceOver Utility, shown below, to set your preferences for voices, rate of speech, pitch, and volume.

Using Different Voices
VoiceOver automatically uses a single default voice to speak what it reads. However, you can choose different voices to speak different types of information. If only the Default Voice appears in the Voices pane, click the disclosure triangle to reveal additional options. The triangle is called the “Show Additional Voices” or “Hide Additional Voices button” depending on its state. Whenever you see a collapsed disclosure triangle, you can click it to reveal more information.

You can set different voices for these types of information:

- **Default Voice**: This voice is used for everything spoken in VoiceOver except any of the options you set.
- **Content**: This voice speaks text in content areas. These can include scroll areas, lists, HTML content areas, and documents.
• **Status:** This voice lets you know the current state of buttons and other controls. For example, the status of a checkbox is either “checked” or “unchecked.”

• **Type:** This voice identifies the type of item. Some examples are button, slider, scroll area, and HTML content area.

• **Attributes:** This voice speaks the text attributes at the beginning of text with different attributes than the preceding text. For example, “bold 15 point” or “12 point Helvetica.”

• **VoiceOver Menu:** This voice reads the commands in the VoiceOver menu.

Click the pop-up menu next to each type of information and select the voice you want to use. If you don’t make a choice, the default voice you chose will speak the information.

You can practice using your VoiceOver skills to change voice settings in the exercise at the end of this chapter.

**Changing Rate, Pitch, and Volume**

Next to each voice pop-up menu are controls to adjust the rate, pitch, and volume of each voice. Type a new value in the text field or use the **incrementors** to change the value.

Adjust the volume to a level that suits you. You can also use the volume controls to add emphasis or tune out information. For example, you may find it useful to set the volume higher for content and lower for other information. If there’s information you’d rather not hear, set the volume to 1, which is the lowest value.

If you want to return all the settings to their default state, click the Reset button. But remember, this changes almost all of the settings in VoiceOver Utility, not just the pane you’re in. The only settings that won’t change are entries in the Pronunciation pane.

You can practice using VoiceOver to change the rate, pitch, and volume in the exercise at the end of this chapter. For information about changing these values temporarily as you work, see “Changing Rate, Pitch, and Volume Temporarily” on page 25.

**Setting Visual Options**

It can be difficult for a person not accustomed to using VoiceOver to follow along when someone else is using it. To help them, VoiceOver provides visual feedback on the screen.
The VoiceOver cursor and the caption panel are two visual aids for sighted users. You can turn these visuals off or on and set preferences for them in the Display pane of VoiceOver Utility, shown below.

**Magnifying the VoiceOver Cursor**
You can magnify the item in the VoiceOver cursor to enhance visibility, or to help you isolate it from the rest of the screen contents. The image below shows the Documents folder magnified in the VoiceOver cursor.

You can use the VoiceOver cursor slider in VoiceOver Utility to adjust the magnification setting. This setting is retained when you restart your computer or log in again to your user account. You can also use a VoiceOver command to temporarily increase or decrease the magnification as you're working. These temporary settings are in effect until you log out or restart your computer.
VoiceOver uses the brace keys for this command. The left and right braces are the shifted keys to the right of the P key.

**To increase or decrease the VoiceOver cursor magnification:**

- Press control-Option-Right brace (}) to increase and Left brace ({) to decrease the magnification.

**Using the Caption Panel**
The caption panel displays what VoiceOver is speaking so that a sighted person can read what VoiceOver is saying, and more easily follow along. The caption panel is shown below.

You can use the options in the Display pane of VoiceOver Utility to change how many lines of text to display and how big the caption panel is. The larger the caption panel, the more space it takes up on the screen. If your caption panel is very large, you may want to increase its transparency so that you can see what is on the screen behind it.

**Moving and Resizing the Caption Panel**
If you can use a mouse, you can drag the caption panel to a part of the screen that works best for you. You can also use VoiceOver commands to resize and move the caption panel. The same command works for both actions, similar to the verbosity settings described previously in “Setting Visual Options” on page 55.

**To move or resize the caption panel:**

1. Press Control-Option-Shift-F10. You hear either “resizing caption panel” or “moving caption panel.” Each time you press the command, you switch to the other setting.

2. Press Control and Option with the arrow keys to make the changes you want.
   - If you are resizing the caption panel, the Up Arrow makes the window larger and the Down Arrow makes it smaller.
   - If you are moving the caption panel, the arrow keys move the window in the direction of the arrow. You can press the Shift key with the arrow keys to move in smaller increments.

3. Press Escape to stop interacting with the caption panel.

**Changing the Caption Panel Font Size**
You used the brace keys to increase or decrease the magnification of items in the VoiceOver cursor. You use the brace keys to increase or decrease the font size in the caption panel. The left and right brackets are the unshifted keys to the right of the P key.
To increase the font size of the caption panel:
- Press Control-Option-Command-Right bracket ( ] ).

To decrease the font size of the caption panel:
- Press Control-Option-Command-Left bracket ( [ ).

The exercises at the end of this chapter will help you practice working with the caption panel and magnifying the VoiceOver cursor.

**Tiling Visuals**
For maximum visual impact, you can dim the screen so that the contents of the VoiceOver cursor stand out brightly. This is called *tiling visuals*. You can see the results in the image below. The screen is dim except for the magnified item in the VoiceOver cursor, which is centered on the screen.

To dim the screen behind the VoiceOver cursor:
- Press Control-Option-F10.

When you want to return the screen to normal, press Control-Option-F10 again.

If the caption panel is turned on, it is centered at the top or bottom of the screen and displayed brightly with the VoiceOver cursor while the rest of the screen is dimmed.

**Hiding Visuals**
Even when the VoiceOver cursor or caption panel are visible, there may be times when you want to temporarily hide them. You can use a VoiceOver command to hide them and then make them visible again.
To turn the VoiceOver cursor and caption panel on or off:
- Press Control-Option-F11. On a portable computer you may need to press Fn-Control-Option-F11.

Setting Text Pronunciation
You can create word substitutions so that when certain text or symbols appear, you hear a preferred word or pronunciation spoken for the text or symbol. You make these adjustments in the Pronunciation pane of VoiceOver Utility, shown below.

VoiceOver comes with some standard pronunciations. You can click the Add button at the bottom of the table to add your own. The Reset button does not change the entries in the pronunciation list, but it does restore all other VoiceOver Utility settings to their original settings. If you want to remove items from the pronunciation list, use the Delete button at the bottom of the Pronunciation pane.

The exercises at the end of this chapter will help you practice adding pronunciations to the list.

Chapter 6 Exercises
The following exercises will help you practice changing voice settings, magnifying the VoiceOver cursor and tiling visuals; moving and resizing the caption panel; and adding a pronunciation to the pronunciation list.

Exercise 6.1: Using VoiceOver to Change Voice Settings
In this exercise, you will use VoiceOver to navigate the Voices pane of VoiceOver Utility and change voice settings. Make sure cursor tracking is turned on before you begin.
1 Press Control-Option-F8 to open VoiceOver Utility. If you’re using a portable computer and have not changed the default behavior of the function keys, press Fn-Control-Option-F8.

2 Press Control-Option-Right Arrow until you hear “Voices tab three of five.”

3 Press Control-Option-Space bar to press the Tab button.

4 Press Control-Option-Right Arrow to hear the remaining tab buttons and the headers for the columns (Voices, Rate, Pitch, and Volume). Stop when you hear “Show Additional Voice Options button.”

5 Press Control-Option-Space bar to press the button and reveal the other information types. You won’t hear them until you navigate to them.

6 Press Control-Option-Right Arrow to move across the Default Voice row. Stop when you hear “Fred. Default Voice pop-up button.”

7 Press Control-Option-Space bar to open the pop-up menu, then use the arrow keys to move up and down the list of voices.

8 Press the Return key to hear the voice you selected read a line of text. Keep sampling voices in this way until you find one you like.

9 Press Control-Option-Right Arrow to navigate to the remaining information types and make selections for these.

**Exercise 6.2: Using VoiceOver to Change Rate, Pitch, and Volume**

In this exercise, you will use VoiceOver to change the rate, pitch, and volume of the voices. Make sure cursor tracking is turned on before you begin. If you did the preceding exercise to choose voices, you can skip to step 5.

1 Press Control-Option-F8 to open VoiceOver Utility. If you’re using a portable computer and have not changed the default behavior of the function keys, press Control-Option-Fn-F8.

2 Press Control-Option-Right Arrow until you hear “Voices tab three of five.”

3 Press Control-Option-Space bar to press the tab button.

4 Press Control-Option-Right Arrow to hear the remaining tab buttons and the headers for the columns (Voices, Rate, Pitch, and Volume). Stop when you hear “Show Additional Voice Options button.”

5 Press Control-Option-Space bar to press the button and reveal the other information types. You won’t hear them until you navigate to them.

6 Press Control-Option-Right Arrow to move across the Default Voice row. Stop when you hear “thirty-five rate edit text.” If this setting has been changed, you may hear a number other than 35.

7 Type a new value. Since the cursors are tracking each other, the value is already selected. When you start typing, the numbers you type replace what was there.
8 Press Control-Option-Right Arrow until you hear “pitch fifty incrementor.” Again, you may hear a different value if this setting was changed.

9 Press Control-Option-Shift-Down Arrow to begin interacting with the incrementor.

10 Press Control-Option-Up Arrow or Control-Option-Down Arrow to change the value. When you stop, you hear the voice speak at the selected pitch.

11 Press Control-Option-Shift-Up Arrow to stop interacting with the incrementor.

12 Press Control-Option-Shift-Right Arrow to move to the Volume column. Use either method to change the value.

**Exercise 6.3: Adjusting the Caption Panel**

In this exercise, you will turn on the caption panel and then change its transparency, font size, and location.

1 Press Control-Option-F8 to open VoiceOver Utility.

2 Press Control-Option-Right Arrow until you reach the Display tab, then press Control-Option-Space bar to open the Display pane.

3 Press Control-Option-Right Arrow until you reach the Show Caption Panel checkbox. If it’s unchecked, press Control-Option-Space bar to check it. The caption panel immediately appears at the bottom of the screen.

4 Press Control-Option-Shift-Right Arrow until you reach the Caption Panel Transparency slider.

5 Press Control-Option-Shift-Down Arrow to begin interacting with the slider.

6 Press Control-Option-Right Arrow to make the caption panel more transparent, so you can see the window behind it.

7 When the transparency is at a level you like, press Control-Option-Shift-Up Arrow to stop interacting with the slider. Notice the caption panel doesn’t block as much of the screen.

8 To position the caption panel somewhere other than the center of the desktop, press Control-Option-Shift-F10 until you hear “moving caption panel.” Then press Control-Option-Down Arrow to move the caption panel toward the bottom of the screen.
When you're finished moving the caption panel, press the Escape key.

Note: You can also use this exercise to practice resizing the caption panel. Press Control-Option-Shift-F10 until you hear “resizing caption panel.” The Up and Down arrows add height and the Left and Right arrows add width to the caption panel.

Exercise 6.4: Magnifying the VoiceOver Cursor and Tiling VoiceOver Visuals
In this exercise, you will practice using VoiceOver commands to magnify the VoiceOver cursor and isolate the VoiceOver cursor in the center of the screen. The brace keys you use for this command are the shifted keys to the right of the P key.

Note: You can use the VoiceOver Menu Magnification slider in the Display pane of VoiceOver Utility to set this level permanently. Using VoiceOver commands as you work maintains the setting only until you log out of your user account or shut down your computer.

1 With VoiceOver turned on, press Control-Option-Shift-Right brace (}) to increase the magnification. Each time you press the command, the magnification increases.
2 Press Control-Option-Shift-Left brace ({) to decrease the magnification. Stop when the magnification is at a comfortable level.
3 Press Control-Option-F10 to dim the screen and show the contents of the VoiceOver cursor in the center of the screen.
4 Press Control-Option-Right Arrow to navigate around the screen. Notice that the contents of the VoiceOver cursor are always in the center of the screen, regardless of where the VoiceOver cursor is actually located.
5 Press Control-Option-F10 again to return the screen to normal.
6 Press Control-Option-Shift-Left brace ({) until the magnification returns to one, the normal setting.

Exercise 6.5: Adding Pronunciation to the VoiceOver Dictionary
In this exercise, you will add a word to the VoiceOver pronunciation dictionary so that it is spoken the way you prefer. Think of a word or term that you would like to use as an example. If your name has a unique pronunciation, you may want to use it instead of the word provided in the exercise.

1 Press Control-Option-F8 to open VoiceOver Utility.
2 Press Control-Option-Right Arrow until you hear “Pronunciation tab five of five.”
3 Press Control-Option-Space bar to click the tab button and open the Pronunciation pane.
4 Press Control-Option-Right Arrow until you reach the Add button, then press Control-Option-Space bar to click the button. A new dialog opens for you to enter the new pronunciation.
5 The first line of the dialog has a text field. Press Control-Option-Right Arrow once to reach the text field, then type the word you chose. If you don't have a word to add, type ASCII with all capital letters.

6 Press Control-Option-Right Arrow until you reach the Pronunciation text box, then type a phonetic spelling for your word. For example, if you are using ASCII, you could type askee.

7 Press Control-Option-Right Arrow to go to the next line, where you choose applications in which you want to use this pronunciation. The default setting is to use the new pronunciation for all applications. If this is what you want, you don't need to do anything else here.

   If you want to use the new pronunciation only for a specific application, click the Applications pop-up menu and choose it from the menu. Only open applications are listed in the menu.

8 Press Control-Option-Right Arrow to go to the Ignore Case checkbox. This checkbox is selected. If you want to use the new pronunciation only for case-specific instances, click the checkbox to deselect it.

9 Press Control-Option-Right Arrow until you reach the Save button, then click it.

   Your pronunciation is now included in the list of terms in the Pronunciation pane of VoiceOver Utility. You can interact with the contents of the list to hear the items it contains.
Web Browsing and Email

Mac OS X comes with an email application and web browser that you can use with VoiceOver.

You can use the Mail and Safari applications to send and receive your email and surf the Internet. This chapter gives you information to help you connect to the Internet and to help you use VoiceOver with Mail and Safari.

Connecting to the Internet
When you set up your new computer, Setup Assistant asks you questions about your Internet Service Provider. If you already have Internet access set up, you can start using Mail and Safari right away. If you skipped the Setup Assistant process or didn’t start with a new computer, you can enter the necessary information in Network preferences.

To open Network preferences:
1 Press Control-Option-D to go to the Dock.
2 Press Control-Option-Right Arrow until you hear “System Preferences,” then press Control-Option-Space bar.
3 Press Control-Option-Right Arrow until you hear “Network” or press Control-Option-I to open the Item menu and locate it.
4 Press Control-Option-Space bar to open Network preferences.
The Network preferences window, shown below, has two pop-up menus at the top. In
the Location pop-up menu, you choose the configuration you’re setting up. If you
always use your computer in the same location and connect the same way, you can
just leave the location set to Automatic. If you want to create different connection
settings for different locations, choose New Location or Edit Locations and use the
dialog that opens to make the necessary changes.

In the Show pop-up menu, you can choose the type of information you want to view in
the table below it. Network Status is on by default, and the table shows the status of
your network connection if you have one, your modem if you have one, and any other
connection information. Choose your connection method from the pop-up menu to
set up your connection.

Before you close the window or quit System Preferences, click the Apply Now button at
the bottom of the window. If you don’t, a dialog appears, asking if you want to save
your changes.

If you need more help getting set up, go to the bottom of the Network preferences
window, below the table, and click the “Assist me” button for guided setup assistance.
Using Mac OS X Mail
With the Mail application in Mac OS X, you can conveniently organize, read, and send email. The toolbar at the top of the Mail window includes a search field so that you can quickly locate email messages by subject, words in the text, sender or recipient, and date sent or received.

The Mail window is organized like a Finder window, with your inbox and any other mailboxes you create in the left column. VoiceOver calls this the “mailboxes outline.” The contents of the folder selected in the mailboxes outline appear in a messages table in the top half of the right column. When you select one of these messages, its contents are displayed in the lower part of the right frame, called a “message content scroll area.”

The first time you open Mail, the Mail Setup Assistant appears to help you set up your email account. You should know the name of the incoming and outgoing mail servers that your Internet Service Provider uses, whether your email account is POP or IMAP, and your email user name and password.

If you need help learning how to set up or use Mail, choose Help > Mail Help from the menu bar.

The Mail Toolbar
The toolbar at the top of the Mail window contains buttons to help you manage your email. You can use these buttons to delete selected messages, label a message as junk, start a new message, reply to a message, get mail, and search.

Opening Collapsed Folders in the Mailboxes Outline
The mailboxes outline on the left side of the Mail window is a lot like the sidebar in the Finder. It contains an Inbox folder that lists your email accounts, separate folders for mail you sent, and any folders you set up to help you manage your email. Just like in the Finder, you select a mailbox in the mailboxes outline, its contents are displayed in the messages column on the right.

Some folders in the mailboxes outline have a triangle next to them so that you can collapse or expand them. You can also use a VoiceOver command to expand a folder and access its contents. The folder contents are shown indented below the folder, just like the Finder’s list view.

To expand or contract a disclosure triangle:
- Press Control-Option-Backslash (\).
Reading Email
Because the Mail window is similar to a Finder window, you can use the same skills discussed in “Navigating Finder Windows” on page 37. You interact with the contents of the mailboxes outline, select a mailbox, and stop interacting. Then you do the same in the messages table to select the message you want to read. To speed up the process, VoiceOver provides a command to jump the VoiceOver cursor from the messages list to the message contents and back again.

If you need more explicit instructions, review “Using List View” on page 38.

To open an email message:
1. Open the Mail application by clicking the Mail icon in the Dock.
2. Navigate to the mailboxes outline and select a mailbox or folder. Use Control-Option-Shift-Down Arrow and Control-Option-Shift-Up Arrow to begin interacting and stop interacting with the contents.
3. Press Control-Option-Right Arrow to move to the messages table. Remember you need to interact with the contents to read the messages in the table.
4. Press Control and Option with the arrow keys to move across or up and down each row of messages. For example, if you want to view messages by sender, move to the From column and press Control-Option-Down Arrow to move down the column.
   
   Note: You can also press Control-Option-R to read the entire row.
5. When you locate an email message you want to read, press Control-Option-J. The VoiceOver cursor jumps to the message content scroll area and begins to read the message.
6. When you're finished reading, press Control-Option-J to jump back to the message list.
   
   Note: You can also use regular VoiceOver window navigation to move to the contents of the email message in the message content scroll area, and you can double-click an email in the message list with the mouse to open the message in a separate window.

Controlling Speech
As VoiceOver reads the text of the message, you can pause the speaking or repeat what was spoken.

To pause VoiceOver speaking:
- Press the Control key.
  
  Press the Control key again to resume. If you haven't moved the VoiceOver cursor, or used another VoiceOver command, VoiceOver will continue reading where it left off.

To hear what was last spoken repeated:
- Press Control-Option-Z.
  
  After VoiceOver repeats the previous spoken text, it continues reading where it left off.
Addressing a Message
Names in your address book appear in the To, CC, and Bcc fields as menu buttons in the Mac OS X Mail application. The address menu buttons function like pop-up menus or contextual menus. In addition to listing all the addresses for an individual or organization, they also list actions you can perform for the address, such as editing it, removing it from the list, opening it in Address Book, creating a Smart Mailbox, and more.

To address a Mail message:
1 Open the Mail application and press Control-Option-Right Arrow until you hear “New button.”
2 Press Control-Option-Space bar. A new mail message opens in a separate window.
3 Press Control-Option-Right Arrow until you hear “blank To edit text.”
4 Type the first few letters of the recipient’s name. You hear the name and email address of the first name that matches what you typed.
   If more than one address is available for the recipient, you hear “Mail has new window” and a list of addresses for that person appears. Press Control-Option-Down Arrow to find the one you want.
5 Press the comma (,) key to enter the address and add another address. You can add as many addresses in the field as you want.
   If you need to delete an address you just entered, press the Delete key once to highlight the address and a second time to delete it.
6 Press Return to move to the next text field.

Note: If you start typing an email address that is already in your address book, pressing Return adds the entire address to the To field. Press Return again to move to the next text field.

Using the Safari Web Browser
Mac OS X includes Safari, a web browser. The Safari window has navigation buttons across the toolbar at the top, a text field where you can type an Internet address, and a Google search field. Below the toolbar are buttons you click to see all your bookmarks and those you use often.

Navigating Websites With VoiceOver
VoiceOver provides three ways to navigate websites:
- You can move the VoiceOver cursor in a linear way, progressing across or down the website by moving from item to item on the page. This method provides excellent control but may slow down navigation if the page contains many items.
• You can select a preference in the Navigation pane of VoiceOver Utility to navigate by group. The VoiceOver cursor moves from one group of information to the next, and you interact with the group if you want to read its contents. This method speeds up navigation and allows you to quickly survey the contents of a page.

• You can use the Link Chooser menu. The Link Chooser menu lists all the links on a page, which lets you quickly jump to the link you want.

You can choose website navigation options in the Navigation pane of VoiceOver Utility, shown below.

For more information about these options, see “Setting Website Navigation Options” on page 53.

Websites often contain a mix of links, graphics, and sometimes moving images. Every website is different, so you’ll need to explore each website to learn how it’s arranged. Very often, websites are laid out in a table to help with alignment of text and graphics. Depending on the way content was created or designed, all elements on a website might not be accessible.

Some webpages organize information in frames. Frames are often used to separate different sections of the page. Sometimes one frame has links in it that update the contents of other frames. For example, you might click a link in one frame to display information in another frame. VoiceOver provides commands to let you move between frames so that you can access this type of webpage.

To navigate from one frame to another:

- Press Control-Option-Command-M to move to the next frame, and Control-Option-Command-Shift-M to move back to the previous frame.

Using the Link Chooser Menu

The Link Chooser menu does for webpages what the Item Chooser menu does for windows. By listing all the links on a webpage, you can quickly find the one you’re looking for and select it. If you don’t know the exact name of the link, just type a keyword to find links that contain the word. For example, if you suspect there’s a link on the page for customer support or technical support, type support to find likely links.

To open the Link Chooser menu:

- Press Control-Option-U.
When you select a link in the Link Chooser menu, the VoiceOver cursor goes to the link on the webpage but doesn’t activate the link. This gives you a chance to determine whether you really want to go there before you actually switch to a new webpage.

You can use the Link Chooser menu in any document or file that contains HTML links, including Mac Help and VoiceOver Help.

To practice using the Link Chooser menu, see the exercise at the end of this chapter.

**Navigating Website Images**

Websites may contain many images. If a website contains “alt tags,” or text that describes each image on the page, you may find it useful to navigate to these images. If a website has unidentified images, you may want to ignore them. You can set your preferences for navigating images in the Navigation pane of VoiceOver Utility.

*Note:* Some images contain links, so you may miss some links on a page if you choose not to navigate images.

**Chapter 7 Exercises**

The exercises that follow will help you practice reading email and navigating websites with Mail and Safari.

**Exercise 7.1: Opening and Reading an Email Message**

In this exercise, you will open the Mail application in the Dock, navigate the Mail window to the message list, and go to the message text to read it. You must already have Mail set up with an email account before you begin this exercise.

1. Press Control-Option-D to open the Dock, then press Control-Option-Right Arrow until you reach the Mail icon.
2. Press Control-Option-Space bar to open the Mail window.
3. Press Control-Option-Right Arrow until you hear “mailboxes outline.” This area is similar to the sidebar in a Finder window. Press Control-Option-Shift-Down Arrow to interact with the contents of the mailboxes area.
4. Press Control-Option-Down Arrow to move through the folders and mailboxes in this area. The contents vary depending on how many email accounts you have and any special folders you set up to manage your email messages.
5. When you reach your email account in the Inbox, press Control-Option-Shift-Up Arrow to stop interacting with the mailboxes outline.
6. Press Control-Option-Right Arrow to reach the messages table and press Control-Option-Shift-Down Arrow to interact with it.
Press Control-Option-Right Arrow to move across the first row in the message table. Depending on the preferences you set for Mail, you may have columns for the status of the menu, who the sender is, the subject, and date and time information.

You can also move down a column, so if you want to read mail from a particular sender, navigate to the From column and then use the Up and Down arrows instead of the Left and Right arrows.

After you locate a message to read, press Control-Option-J to move to the message contents below the message table. Notice that VoiceOver begins reading the text automatically.

Press Control to pause the speech and Control again to resume.

Press Control-Option-Right Arrow and notice that VoiceOver stops reading the text automatically, and you are now interacting with the text.

You can use the text commands described in “Reading Text” on page 25 or in “Reading a Document” on page 72 to read a line or sentence at a time. For this exercise, you will return to reading the message contents as a whole.

Press Control-Option-Up Arrow to stop interacting with the text, then press Control-Option-A to start reading the message contents from the start again.

When you’re finished reading the email message, press Control-Option-J to return to the messages table.

Exercise 7.2: Using the Link Chooser Menu
In this exercise, you will open a page in Safari or VoiceOver Help, open the Link Chooser menu, and find a link.

Press Control-Option-D to open the Dock, or press Control-Option-Question mark (?) to open VoiceOver Help.

If you are using Safari, press Control-Option-Right Arrow until you hear “Safari,” then press Control-Option-Space bar to open a webpage in Safari.

Press Control-Option-Left Arrow to move to the HTML content area.

*Note:* This is a shortcut to bypass all the toolbars and tabs that may be at the top of a browser window. Technically, the VoiceOver cursor is actually navigating backward.

Press Control-Option-Shift-Down Arrow to interact with the HTML content area.

Press Control-Option-U to open the Link Chooser menu.

Type a word that you’re likely to find in a link on the webpage. In Safari, if your start page is set to an Apple website, try Mac. If you’re in VoiceOver Help, type commands.

Press Control-Option-Down Arrow to find the link you want, then press Control-Option-Space bar. The Link Chooser menu closes and the VoiceOver cursor moves to the link on the page that you selected.

Press Control-Option-Space bar to activate the link and open the linked page.
This chapter provides information about reading, typing, and editing text.

Text is found in many places on your computer: in windows and dialogs, in content areas like webpages and help files, and in documents. You can use the navigation skills covered earlier to navigate to text areas and interact with them. This chapter teaches you how to use the VoiceOver text commands effectively.

Reading a Document
When you open a document, it opens in the application that created it or in another compatible application. When the document opens, you often have to navigate through the application's toolbar and text rulers that appear. A tip for quickly accessing the content is to press Control-Option-Left Arrow to navigate backward to the last item on the page, which is typically the text area.

Note: If while navigating, you find yourself stuck in a text ruler full of tab markers, it's easy to get out. Press Control-Option-End (or Control-Option-Fn-Right Arrow on a portable computer) to go to the last visible item on the page, which is usually the text area.

When you reach the text area in a document, press Control-Option-A to begin reading the text. You don’t have to interact with the text to read it. Press Control to pause the reading, and press it again to continue where VoiceOver left off. If you need to hear the last phrase repeated, press Control-Option-Z. VoiceOver repeats the last sentence or phrase and continues reading the rest of the text.

When you press Control-Option-Shift-Down Arrow to interact with the text area, Control-Option-A reads from where the VoiceOver cursor is located to the bottom of the text area. Use the VoiceOver commands in “Working With Text” below for even greater control of the VoiceOver cursor.
Working With Text
When you’re writing and editing in the text area, you are most likely working word-by-word or in small chunks of text. You can use the following commands to read the next or previous character, word, line, sentence, or paragraph:
- Word: Control-Option-Right Arrow or Left Arrow
- Character: Control-Option-Shift-Right Arrow or Left Arrow
- Line: Control-Option-Down Arrow or Up Arrow
- Sentence: Control-Option-Page Down or Page Up
- Paragraph: Control-Option-Shift-Page Down or Page Up

Locating the Insertion Point
When you work with text, the keyboard focus is represented by a blinking vertical line, also known as an insertion point. This shows you where the next character you type is going to appear. As you type, the insertion point is always to the right of the character you just typed. VoiceOver extends this experience to how VoiceOver speaks characters and words. VoiceOver speaks the character or word as it passes over it. If you’ve used another screen reader, you may be accustomed to a different experience. With a little practice, it doesn’t take long to get familiar with this new orientation.

To figure out where the insertion point is in relation to a word or character, remember that it always rests on the other side of what VoiceOver just spoke. This is important to remember, because if you move backward over a character or word, the VoiceOver cursor and the insertion point are focused before the character or word. Try the exercise at the end of this chapter to practice working with text.

Navigating in a Document
In addition to navigating within the text itself, you can use VoiceOver commands to navigate to the beginning or end of the document. Remember that if there is more content than can be shown in the window, the window will have scroll bars. If you use the first two commands below, the VoiceOver cursor moves only to the top or bottom of what’s visible in the scroll area. Use the second two commands to reach the top or bottom of all the contents of the scroll area.

To move the VoiceOver cursor to the first visible word:
- Press Control-Option-Home on a desktop computer or Fn-Control-Option-Left Arrow on a portable computer.

To move the VoiceOver cursor to the last visible word:
- Press Control-Option-End on a desktop computer or Fn-Control-Option-Right Arrow on a portable computer.

To move the VoiceOver cursor to the first word, scrolling if necessary:
- Press Control-Option-Shift-Home on a desktop computer and Fn-Control-Option-Shift-Left Arrow on a portable computer.
To move the VoiceOver cursor to the last word, scrolling if necessary:
- Press Control-Option-Shift-End on a desktop computer and Fn-Control-Option-Shift-Right Arrow on a portable computer.

**Bookmarking a Document**
You can place a bookmark in a text document so that you can quickly return to a particular place. You can place only one bookmark, so the second time you set a bookmark, it replaces the first one. Bookmarks are useful for quickly returning to a particular location in a long document.

**To use bookmarks:**
- Position the VoiceOver cursor where you want to place a bookmark, then press Control-Option-Shift-1.
- Press Control-Option-1 to move the VoiceOver cursor to a bookmark.

Bookmarks are only temporary. If you close the document where you've placed a bookmark, or if you quit the application, the bookmark is not saved.

**Cursor Tracking in Text Areas**
VoiceOver Utility has unique cursor tracking options for working with text. If you want the VoiceOver cursor and insertion point to track each other while you're working with text, select both of the text selection tracking options in the Navigation pane of VoiceOver Utility, shown below.

With these options selected, anything you select with the keyboard will also be in the VoiceOver cursor.

**Selecting Text**
To copy, paste, or delete text, you need to select the text first. You use standard Mac OS X keyboard shortcuts to select text.

**To select one character at a time:**
- Press Shift-Right Arrow or Shift-Left Arrow to select the character to the right or left of the insertion point.

**To select one word at a time:**
- Press Shift-Option-Right or Left Arrow.
To select the text from the keyboard cursor to the end or beginning of the line:
- Press Shift-Command-Right or Left Arrow.

You can use the VoiceOver command Control-Option-F6 to verify exactly what is selected.

**Important:** When text is selected, you can easily delete it by pressing any key on the keyboard. This is useful if you want to replace the selected text with the words you type. If you accidentally delete the text, use the keyboard shortcut Command-Z to undo your mistake. This correction works only if it occurs immediately after the mistake. This shortcut works in many applications and in many situations. It's always worth trying it to see if it can correct a mistake.

**Hearing Text Attributes**
The font, size, and style of text adds meaning to a formatted document. “Adjusting Text Attribute Settings” on page 52 discussed how to set the way VoiceOver announces changes in text attributes as text is being read. When you're working with text, you can use a VoiceOver command to hear text attributes for selected text.

To hear the attributes of selected text:
- Press Control-Option-T.

You won't hear the attributes if the text is not selected. Use one of the previously discussed text selection commands in “Selecting Text” above.

**Using TextEdit With VoiceOver**
TextEdit is the powerful word processing application built in to Mac OS X. TextEdit is fully accessible with VoiceOver, and you can use it to open, read, and edit many documents created by other word processing applications, including Microsoft Word. You use all the standard VoiceOver commands to navigate the TextEdit window and interact with toolbars, menus, and text. You can also use TextEdit Help to learn how to use the many powerful features and keyboard shortcuts in TextEdit. A few tips are provided here to get you started.

**Checking Spelling in TextEdit**
TextEdit has a preference you can set that underlines misspelled words. If you can't see the underlining, you can still use TextEdit's spell check feature to check spelling at any time. A combination of TextEdit keyboard shortcuts and VoiceOver commands makes this a simple task.

**To check spelling in a document:**
1 Move the VoiceOver cursor to an edit text area.
2 Press Command-semicolon (;) to hear the first misspelled word. Sometimes words are underlined that the computer doesn’t recognize, but they’re not actually misspelled. Continue pressing this command until you hear a word that needs to be corrected.

3 Press Control-Option-Shift-M to open a contextual menu for the misspelled word. At the top of the menu are suggested spellings or alternate words. Below those are other options, including a dictionary so you can find the definition of the word.

4 Navigate to the menu choice that you want and press Control-Option-W-W to hear its spelling, or Control-Option-W-W-W to hear it spelled phonetically.

5 Press Control-Option-Space bar to select it. If you choose a corrected spelling from the menu, the new spelling replaces the old one.

If you don’t hear an acceptable correction, press Escape to close the menu. Then press Control-Option-Shift-F4 to move the VoiceOver cursor to the misspelled word and edit the word manually.

**Changing Tab Stops in TextEdit**

At the far right end of the toolbar are tab stop buttons you can press to add a new tab stop. You can click these buttons or you can add a tab stop at any point when the VoiceOver cursor is in the ruler. If you deselected the Show Ruler checkbox in TextEdit Preferences, you won’t find these buttons or the ruler.

**To add or change a tab stop:**

1 Press Control-Option-Space bar when the VoiceOver cursor is on a tab stop button or in the ruler. In either case, a dialog appears.

2 Press Control-Option-Right Arrow to go to the pop-up menu labeled Right Tab Stop.

3 Press Control-Option-Space bar to open the pop-up menu list and choose the type of tab stop you want to add.

4 Press Control-Option-Right Arrow until you reach the edit text field for the ruler marker value.

5 Type the measurement for where you want to place the tab stop. For example, 6.25 indicates six and one quarter inches on the ruler.

6 Press Control-Option-Right Arrow until you reach the Ok button and click it.

You can also drag existing tab stop markers along the ruler.

**To drag an existing tab stop marker to another location:**

1 Navigate to the ruler and locate the tab stop marker you want to move.

2 Press Control-Option-Shift-Down Arrow to interact with the marker.

3 Press Control-Option-Left Arrow or Right Arrow until the marker is where you want it.

4 Press Control-Option-Shift-Up Arrow to stop interacting with the marker.
Chapter 8 Exercises
The exercises that follow will help you practice locating the insertion point, selecting text, and saving a document. The first exercise tells you how to open a new document in TextEdit. You can use the same document for all the exercises.

Exercise 8.1: Following the Insertion Point
In this exercise, you will use Spotlight to find the TextEdit application, create a new document in TextEdit, and practice locating the insertion point.

1. Press Control-Option-M three times to open the Spotlight menu.
2. Type text.
3. Press Control-Option-Down Arrow until you hear “TextEdit top hit.”
5. Press Control-Option-Left Arrow to go backward to the text area and skip all the items in the toolbar and text ruler.
6. Press Control-Option-Shift-Down Arrow so you can type in the text area.
7. Type leaf. The VoiceOver cursor and insertion point are focused to the right of the f.
8. Press Control-Option-Shift-Left Arrow to move back one character and you hear “f” again because now the VoiceOver cursor moved over the f, reading as it went. The insertion point is now blinking on the left of the f.
9. Press Control-Option-Shift-Left Arrow again to move back one character and you hear “a” and the insertion point is now to the left of the a.
10. Continue moving forward and back using Control-Option-Shift-Left Arrow and Control-Option-Shift-Right Arrow to move a character at a time.

As you move back and forth, you will understand how VoiceOver communicates the location of the insertion point.

Exercise 8.2: Cutting and Pasting Text
In this exercise, you will use a Text Edit document to select text and place a bookmark in the text. You can use the same document you created in the previous exercise.

1. Type some text in the document. Make sure you include this sentence: The sun shone hot on the pavement.
2. Press Control-Option-Page Down or Page Up to navigate the text by sentence until you hear “the sun shone hot on the pavement.” If you have a portable computer, remember to press Fn-Control-Option-Up Arrow or Down Arrow.
3. The insertion point is at the beginning of the sentence, so press Shift-Option-Right Arrow until every word in the sentence is selected.
If you make a mistake, press Control-Option-Right Arrow to deselect the text, then try again.

4 With the sentence selected, press Command-X to cut the text. The text disappears from the document and is stored on the computer's clipboard, which is not visible on the screen.

5 Navigate to the end of the text using any of the navigation methods you learned in this chapter. For example, pressing Control-Option-Shift-End on a desktop computer or Fn-Control-Option-Shift-Right Arrow on a portable computer takes the VoiceOver cursor to the last word in the text area.

6 Press Command-V to paste the sentence you cut.

7 Press Control-Option-S to hear the sentence to verify that it was pasted correctly.

Exercise 8.3: Saving a Document
In this exercise, you will save the document you created in the previous exercises. Mac OS X uses the same Save dialog for all of its applications, so learning how to navigate this dialog is important.

1 Press Command-S to use the keyboard shortcut for saving a document. The Save command is in the File menu in the menu bar.

The first time you save a document, the Save dialog appears. If you are saving changes to a document that has already been saved, the changes are saved, but a dialog doesn't appear.

2 Create a name for the document. Press Control-Option-Right Arrow to go to the edit text field and type the name you want to use. A suggested name is in the text field and is highlighted. When you start typing, you erase the suggested name and replace it with your own.

3 Press Control-Option-Right Arrow until you reach the pop-up menu next to Where.

4 Press Control-Option-Space bar to open the pop-up menu so you can choose where you want to save the document. Choose a folder from the list.

This pop-up menu shows folders that you use frequently. If you don't find the location you want, you can press the disclosure button again to open a navigation window. For this exercise, any folder in the pop-up menu will do.

5 Press Control-Option-Right Arrow until you reach the Save button and press Control-Option-Space bar to click it.
This chapter explains how to navigate using the VoiceOver cursor, keyboard cursor, and mouse pointer—separately and together.

Using the keyboard, mouse pointer, and VoiceOver cursor independently can give you more flexibility as you work. You've already been introduced to cursor tracking, but this chapter provides detailed information. This chapter also provides information about making the mouse more accessible.

**Full Keyboard Navigation and VoiceOver**

Mac OS X has built-in keyboard navigation separate from VoiceOver. Users who don't use VoiceOver can still use their keyboards to navigate menus, select checkboxes and radio buttons, press buttons, and enter text in text fields. Full keyboard access and VoiceOver work together seamlessly, so you can take advantage of all the built-in keyboard shortcuts along with the powerful commands in VoiceOver.

Try the exercise at the end of this chapter to practice using full keyboard navigation to switch between applications.

You can find more information about using full keyboard access in Mac Help and in the Keyboard & Mouse preferences pane in System Preferences.

**Advanced Cursor Tracking**

When you use the keyboard to move to a control, the keyboard is “focused” there. The item is highlighted, or a blinking i-beam cursor appears in a text document to show where the next keyboard action will occur. The mouse pointer and the keyboard focus are closely linked; for example, when you use the mouse to select a file, the keyboard focus also moves to the file.
VoiceOver preferences are set so that the keyboard focus and the VoiceOver cursor track each other. This is called cursor tracking. Wherever you move the keyboard focus with the Tab or Arrow keys using full keyboard navigation, the VoiceOver cursor follows. When you move the VoiceOver cursor, the keyboard focus follows if it can. The keyboard can’t move to every item on the screen the way VoiceOver can.

You can also work with cursor tracking turned off. When you turn off cursor tracking, you can leave your keyboard focus in one place and move the VoiceOver cursor around to read a dialog that just appeared, check email, or perform other tasks while your keyboard focus stays where you left it. With a simple command, you quickly bring them back together.

You can do the same for the mouse. For example, you could use the mouse or Mouse Keys to locate something on the screen, and then use a command to move the VoiceOver cursor to where the mouse pointer is located.

### Using the Cursor Control Keys

You can use the mouse, keyboard, and VoiceOver cursor to navigate to text and objects that appear on your screen. VoiceOver uses three function keys to describe the keyboard, VoiceOver cursor, and mouse pointer.

**Note:** If you use a portable computer and have not changed the default settings for the function keys in Keyboard & Mouse preferences, you must press the Fn key to use these keys for VoiceOver commands. See “Using Function Keys on Portable Computers” on page 18.

**F3 — The VoiceOver Cursor Key**

- **Press Control-Option-F3** to hear a description of the item in the VoiceOver cursor. This could be a control, text in a document, an HTML content area, and more. The description includes the current state of the item. For example, you might hear that the checkbox is selected, or hear the value settings of a slider.

**F4 — The Keyboard Key**

- **Press Control-Option-F4** to hear a description of the item on which the keyboard is focused. The description includes the current state of the item, and, if it applies, whether it is enabled or disabled.

- **Press Control-Option-Shift-F4** to move the VoiceOver cursor to where the keyboard is focused. When you move the keyboard focus, the VoiceOver cursor remains where you moved it. Use this command when cursor tracking is turned off.

- **Press Control-Option-Command-F4** to move the keyboard focus to the VoiceOver cursor. When you move the keyboard focus again, the VoiceOver cursor does not move with it. Use this command when cursor tracking is turned off.
F5—The Mouse Key

- **Press Control-Option-F5** to hear a description of what is under the mouse pointer.
- Press Control-Option-F5 a second time to hear the location of the mouse pointer as x and y coordinates. The origin point is the top-left corner of the main display, where the Apple menu is located.
- **Press Control-Option-Shift-F5** to move the VoiceOver cursor to where the mouse pointer is located. When you move the mouse, the VoiceOver cursor remains where you moved it. Use this command when cursor tracking is turned off, or if you don’t have mouse tracking options turned on in VoiceOver Utility.
- **Press Control-Option-Command-F5** to move the mouse pointer to the VoiceOver cursor. When you move the mouse again, the VoiceOver cursor does not move with it. Use this command when cursor tracking is turned off, or if you don’t have mouse tracking options turned on in VoiceOver Utility.

Try the exercise at the end of this chapter to practice moving the cursors independently.

Using the Mouse With VoiceOver

VoiceOver and Mac OS X provide several options to help you use the mouse.

Mouse Settings in VoiceOver Utility

The Verbosity pane of VoiceOver Utility includes two very useful settings for using your mouse with VoiceOver:

Select the “Speak text under mouse after delay” checkbox so that you can hear the text under the mouse pointer. If you have some vision but have trouble reading text, this is one way to use the mouse selectively to read.

VoiceOver follows your punctuation settings when it reads text under the mouse. So, if you want to hear text attributes, you also hear them for the text under the mouse pointer.

You can move the slider next to the checkbox to set the amount of time you want VoiceOver to wait before speaking. Move the slider left to shorten the delay and to the right for a longer delay.

The “Announce when mouse cursor enters a window” checkbox sets VoiceOver to announce the name of the window the mouse enters. This can be useful if you have little or no vision but want to use the mouse to locate items on the screen. When you move the mouse to a new window, VoiceOver says “entering” and the name of the window.
Making the Mouse Pointer More Visible
In Mac OS X, you can increase the size of the mouse pointer so that you can locate it more easily on the screen. When the pointer changes to an insertion point, crosshair, or any other shape, these shapes are also magnified.

To increase the size of the mouse pointer:
1 Click the System Preferences icon in the Dock or choose Apple menu > System Preferences to open System Preferences.
2 Click the Mouse button. On a portable computer, click Mouse & Trackpad.
3 Move the Cursor Size slider to the right to make it larger.

If you need to make the mouse pointer very large, you might need to practice placing the pointer correctly to activate controls.

Using the Numeric Keypad to Control the Mouse
If you are able to see the mouse pointer but have difficulty using the mouse, you can turn on Mouse Keys in Universal Access preferences. Mouse Keys lets you use the numeric keypad to move the pointer and click items on the screen. When Mouse Keys is turned on, you use the numeric keypad keys to move the mouse pointer. If you are using the built-in keyboard on a portable computer, press the Fn key to use the U, I, O, J, K, L, and M keys as a numeric keypad. If you have difficulty finding these keys, use the VoiceOver Keyboard Practice feature described in Chapter 3.

To turn on Mouse Keys:
1 Open System Preferences and click Universal Access.
2 Click the Mouse button. On a portable computer, click the Trackpad & Mouse button instead.
3 Select the On button for Mouse Keys.

The table below shows you the keys to press for a standard keyboard and a portable computer keyboard.

To use the numeric keypad to control the mouse:

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcuts</th>
<th>Portable Computer Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move up</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Move down</td>
<td>2</td>
<td>K</td>
</tr>
<tr>
<td>Move left</td>
<td>4</td>
<td>U</td>
</tr>
<tr>
<td>Move right</td>
<td>6</td>
<td>O</td>
</tr>
<tr>
<td>Move diagonally</td>
<td>1, 3, 7, 9</td>
<td>J, L, 7, 9</td>
</tr>
<tr>
<td>Click the mouse button</td>
<td>5</td>
<td>I</td>
</tr>
</tbody>
</table>
For more information about this and other accessibility features, see Mac Help.

Quickly Navigating to Content Areas
VoiceOver treats the items in a window as a continuous loop, so if you are at the top of a window and press Control-Option-Left Arrow, you go to the last item in the window. You hear audible cues when you wrap to the next line, or wrap from top to bottom or bottom to top.

If the VoiceOver cursor is in a webpage or a text document, the application may have a lot of controls at the top of the window, such as buttons, links, tab markers, or bookmarks. If you just want to get to the main body of the content quickly without having to key through all these items, you can avoid them by moving backward one or two places. For websites and other windows, this often places the VoiceOver cursor on the HTML content area or the text area.

To move to the bottom quickly:
- Press Control-Option-Left Arrow.

You can also use a VoiceOver command to move to the last item on the page, which is often an HTML content area or a text area.

To move to the last item on the page:
- Press Control-Option-Shift-End, or Fn-Control-Option-Right Arrow on a portable computer.

Chapter 9 Exercises
The following exercises will help you practice using cursor navigation and full keyboard navigation.

Exercise 9.1: Using Command-Tab to Switch Applications
In this exercise, you’ll use a keyboard command to hear which applications are open and switch to one of them. For a better experience, you should have several applications open.

1. Press and hold the Command key.
2. Press the Tab key to hear the open applications. Each time you press Tab, you hear the next open application.
3 Release the keys when you hear the application you want to switch to. If the application has an open window, the window becomes active and the VoiceOver cursor moves there. If no window is open, the application becomes active and you can begin using its menu to perform actions.

**Exercise 9.2: Moving Cursors Independently**

In this exercise, you’ll move the VoiceOver cursor to a text field and start typing. Next, you’ll turn off cursor tracking and try the same thing. Notice the different experience.

1 Press Command-F5 to turn on VoiceOver.

2 Make sure the Finder is the active application. Then press Command-N to open a new Finder window.

3 Press and hold the Control and Option keys while you press the Right Arrow keys. Listen to the descriptions of items and stop when you hear “search text field.”

4 Type some text in the field.

5 Notice that you could type in the field because the keyboard and VoiceOver cursor were in the same location. Now see what happens when you turn off cursor tracking.

6 Press Control-Option-Left Arrow until you hear “list view switcher radio button.”


8 Press Control-Option-Right Arrow until you hear “search text field.” Notice that the List View Switcher button is highlighted and the search field is in the VoiceOver cursor.

9 Press the Return key. The keyboard presses the List View Switcher button and the Finder window view changes.

10 Type some text and notice that no keys register. This is because the keyboard is still on the List View Switcher button.

11 Press Control-Option-Command-F4 and start typing. Notice that the keyboard focus moves to the search text field so that you can type.
VoiceOver Commands

You use the Control and Option keys with other keys to control VoiceOver. If you have an iBook or PowerBook computer, you may need to press the Fn key when you press a function key.

<table>
<thead>
<tr>
<th>Action</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Lock and unlock the Control and Option keys</td>
<td>Control-Option-Semicolon (:)</td>
</tr>
<tr>
<td>Turn VoiceOver on and off</td>
<td>Command-F5</td>
</tr>
<tr>
<td>Open the VoiceOver menu</td>
<td>Control-Option-F7</td>
</tr>
<tr>
<td>Open VoiceOver Help</td>
<td>Control-Option-Question mark (?)</td>
</tr>
<tr>
<td>Get help for an item</td>
<td>Control-Option-H</td>
</tr>
<tr>
<td>Open the Commands menu for an item</td>
<td>Control-Option-H two times</td>
</tr>
<tr>
<td>Open VoiceOver Utility</td>
<td>Control-Option-F8</td>
</tr>
<tr>
<td>Start keyboard practice</td>
<td>Control-Option-K</td>
</tr>
<tr>
<td>Close a menu, stop an action, or exit a mode</td>
<td>Control-Option-Escape (Esc)</td>
</tr>
<tr>
<td>Tell VoiceOver to ignore the next key combination you press</td>
<td>Control-Option-Tab</td>
</tr>
<tr>
<td>Change the speech, rate, pitch, and volume</td>
<td>Control-Option-Command-Right Arrow or Control-Option-Command-Left Arrow to move to the next or previous setting (rate, then pitch, then volume). Then press Control-Option-Command-Up Arrow to increase and Control-Option-Command-Down Arrow to decrease.</td>
</tr>
<tr>
<td>Change the amount of detail (verbosity) you hear for typing echo, punctuation, and text attributes</td>
<td>Control-Option-V Then press the Left or Right Arrow key to choose the setting: typing echo, punctuation, or text attributes. Use the Up and Down Arrow keys to change the level for the setting. Press the Escape key to leave this mode.</td>
</tr>
<tr>
<td>Magnify the item in the VoiceOver cursor</td>
<td>Control-Option-Right brace (})</td>
</tr>
<tr>
<td>Action</td>
<td>Commands</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Shrink the item in the VoiceOver cursor</td>
<td>Control-Option-Left brace ( { )</td>
</tr>
<tr>
<td>Temporarily hide or show the VoiceOver cursor and caption panel</td>
<td>Control-Option-F11</td>
</tr>
<tr>
<td>Dim the screen, highlight the caption panel, and show the item in</td>
<td>Control-Option-F10</td>
</tr>
<tr>
<td>the VoiceOver cursor in the center of the screen (tile visuals)</td>
<td>Press again to return to the normal view.</td>
</tr>
<tr>
<td>Resize or move the caption panel</td>
<td>Control-Option-Shift-F10</td>
</tr>
<tr>
<td>Increase the font size in the caption panel</td>
<td>Control-Option-Command-right bracket ([)</td>
</tr>
<tr>
<td>Decrease the font size in the caption panel</td>
<td>Control-Option-Command-left bracket ([)</td>
</tr>
<tr>
<td>Turn the screen black (screen curtain)</td>
<td>Control-Option-Shift-F11</td>
</tr>
<tr>
<td><strong>Orientation</strong></td>
<td></td>
</tr>
<tr>
<td>Application summary</td>
<td>Control-Option-F1</td>
</tr>
<tr>
<td>Application Chooser menu</td>
<td>Control-Option-F1 two times</td>
</tr>
<tr>
<td>Window summary</td>
<td>Control-Option-F2</td>
</tr>
<tr>
<td>Window Chooser menu for the active application</td>
<td>Control-Option-F2 two times</td>
</tr>
<tr>
<td>Describe the item in the VoiceOver cursor</td>
<td>Control-Option-F3</td>
</tr>
<tr>
<td>Describe the item that has keyboard focus</td>
<td>Control-Option-F4</td>
</tr>
<tr>
<td>Describe the item under the mouse pointer</td>
<td>Control-Option-F5</td>
</tr>
<tr>
<td>Describe the location of the mouse in x, y coordinates (from top-left corner of screen)</td>
<td>Control-Option-F5 two times</td>
</tr>
<tr>
<td>Click the item under the mouse pointer</td>
<td>Control-Option-Shift-Space bar</td>
</tr>
<tr>
<td></td>
<td>Press once for a single mouse click and two times to double-click.</td>
</tr>
<tr>
<td>Describe the selected item</td>
<td>Control-Option-F6</td>
</tr>
<tr>
<td>Read everything in the VoiceOver cursor</td>
<td>Control-Option-A</td>
</tr>
<tr>
<td>Read everything visible in the window</td>
<td>Control-Option-Shift-W</td>
</tr>
<tr>
<td>Repeat the last spoken phrase</td>
<td>Control-Option-Z</td>
</tr>
<tr>
<td>Save the last spoken phrase and the crash log to a file on the</td>
<td>Control-Option-Shift-Z</td>
</tr>
<tr>
<td>desktop for troubleshooting</td>
<td></td>
</tr>
<tr>
<td><strong>Navigation</strong></td>
<td></td>
</tr>
<tr>
<td>Move up</td>
<td>Control-Option-Up Arrow</td>
</tr>
<tr>
<td>Move down</td>
<td>Control-Option-Down Arrow</td>
</tr>
<tr>
<td>Move to previous</td>
<td>Control-Option-Left Arrow</td>
</tr>
<tr>
<td>Move to next</td>
<td>Control-Option-Right Arrow</td>
</tr>
<tr>
<td>Action</td>
<td>Commands</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------</td>
</tr>
</tbody>
</table>
| Move to the top of the visible area, such as the window or text area, where the VoiceOver cursor is located | Control-Option-Home
On a portable computer, press Fn-Control-Option-Left Arrow. |
| Move to the bottom of the visible area, such as the window or text area, where the VoiceOver cursor is located | Control-Option-End
On a portable computer, press Fn-Control-Option-Left Arrow. |
| Move to the top of the area, such as the window or text area, where the VoiceOver cursor is located, scrolling if necessary | Control-Option-Shift-Home
On a portable computer, press Fn-Control-Option-Shift-Left Arrow. |
| Move to the bottom of the area, such as the window or text area, where the VoiceOver cursor is located, scrolling if necessary | Control-Option-Shift-End
On a portable computer, press Fn-Control-Option-Shift-Right Arrow. |
| Move to the top of the window                                         | Control-Option-Command-Home
On a portable computer, press Fn-Control-Option-Command-Left Arrow. |
| Move to the bottom-right corner of the window                        | Control-Option-Command-End
On a portable computer, press Fn-Control-Option-Command-Right Arrow. |
<p>| Move to the front the window where the VoiceOver cursor is located and make it active | Control-Option-Shift-F2 |
| Close the window where the VoiceOver cursor is located               | Control-Option-Command-F2 |
| List the links on a page                                              | Control-Option-U                                  |
| List the items in a window                                            | Control-Option-I                                  |
| Move to the Dock                                                     | Control-Option-D                                  |
| Move to the Desktop                                                  | Control-Option-Shift-D                            |
| Move to the menu bar                                                 | Control-Option-M                                 |
| Move to the first status menu in the menu bar                       | Control-Option-M two times                        |
| Open the Spotlight menu                                             | Control-Option-M three times                      |
| Open a contextual menu                                              | Control-Option-Shift-M                            |
| Jump to a linked item (for example, from a Mail message in the Inbox to its message text) | Control-Option-J |
| Move to the next frame in an HTML content area (such as a webpage)  | Control-Option-Command-M                         |
| Move to the previous frame in an HTML content area (such as a webpage) | Control-Option-Command-Shift-M                    |
| Move back, retracing the movements of the VoiceOver cursor          | Control-Option-Left bracket (])                  |
| Move forward, retracing the movements of the VoiceOver cursor       | Control-Option-Right bracket (])                  |
| Turn cursor tracking on or off temporarily                           | Control-Option-Shift-F3                          |</p>
<table>
<thead>
<tr>
<th>Action</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move VoiceOver cursor to keyboard focus</td>
<td>Control-Option-Shift-F4</td>
</tr>
<tr>
<td>Move keyboard focus to VoiceOver cursor</td>
<td>Control-Option-Command-F4</td>
</tr>
<tr>
<td>Move VoiceOver cursor to mouse</td>
<td>Control-Option-Shift-F5</td>
</tr>
<tr>
<td>Move mouse to VoiceOver cursor</td>
<td>Control-Option-Command-F5</td>
</tr>
<tr>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Read all text</td>
<td>Control-Option-A</td>
</tr>
<tr>
<td>If you are interacting with the text, this command reads from the VoiceOver cursor to the end of the text.</td>
<td></td>
</tr>
<tr>
<td>Get text attributes</td>
<td>Control-Option-T</td>
</tr>
<tr>
<td>Add a bookmark in text</td>
<td>Control-Option-Shift-1</td>
</tr>
<tr>
<td>Jump to a bookmark in text</td>
<td>Control-Option-1</td>
</tr>
<tr>
<td>Read paragraph in VoiceOver cursor</td>
<td>Control-Option-P</td>
</tr>
<tr>
<td>Read next paragraph</td>
<td>Control-Option-Shift-Page Down</td>
</tr>
<tr>
<td>Read previous paragraph</td>
<td>Control-Option-Shift-Page Up</td>
</tr>
<tr>
<td>Read sentence in VoiceOver cursor</td>
<td>Control-Option-S</td>
</tr>
<tr>
<td>Read next sentence</td>
<td>Control-Option-Page Down</td>
</tr>
<tr>
<td>Read previous sentence</td>
<td>Control-Option-Page Up</td>
</tr>
<tr>
<td>Read line in VoiceOver cursor</td>
<td>Control-Option-L</td>
</tr>
<tr>
<td>Read next line</td>
<td>Control-Option-Down Arrow</td>
</tr>
<tr>
<td>Read previous line</td>
<td>Control-Option-Up Arrow</td>
</tr>
<tr>
<td>Read word in VoiceOver cursor</td>
<td>Control-Option-W</td>
</tr>
<tr>
<td>Press twice to hear the word spelled; press a third time to hear the word spelled phonetically.</td>
<td></td>
</tr>
<tr>
<td>Read next word</td>
<td>Control-Option-Right Arrow</td>
</tr>
<tr>
<td>Read previous word</td>
<td>Control-Option-Left Arrow</td>
</tr>
<tr>
<td>Read character in VoiceOver cursor</td>
<td>Control-Option-C</td>
</tr>
<tr>
<td>Press twice to hear the phonetic character.</td>
<td></td>
</tr>
<tr>
<td>Read next character</td>
<td>Control-Option-Shift-Right Arrow</td>
</tr>
<tr>
<td>Read previous character</td>
<td>Control-Option-Shift-Left Arrow</td>
</tr>
<tr>
<td>Move to first visible word</td>
<td>Control-Option-Home</td>
</tr>
<tr>
<td>On a portable computer, press Fn-Control-Option-Left Arrow.</td>
<td></td>
</tr>
<tr>
<td>Move to last visible word</td>
<td>Control-Option-End</td>
</tr>
<tr>
<td>On a portable computer, press Fn-Control-Option-Right Arrow.</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Commands</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Move to beginning of text, scrolling if</td>
<td>Control-Option-Shift-Home</td>
</tr>
<tr>
<td>necessary</td>
<td>On a portable computer, press Fn-Control-</td>
</tr>
<tr>
<td></td>
<td>Option-Shift-Left Arrow.</td>
</tr>
<tr>
<td>Move to end of text, scrolling if necessary</td>
<td>Control-Option-Shift-End</td>
</tr>
<tr>
<td></td>
<td>On a portable computer, press Fn-Control-</td>
</tr>
<tr>
<td></td>
<td>Option-Shift-Left Arrow.</td>
</tr>
<tr>
<td>Add new tab stop (in TextEdit)</td>
<td>Control-Option-Space bar</td>
</tr>
<tr>
<td>Delete the current tab stop (in TextEdit)</td>
<td>Control-Option-Delete</td>
</tr>
<tr>
<td>Interact with tab stop (in TextEdit)</td>
<td>Control-Option-Shift-Down Arrow</td>
</tr>
<tr>
<td></td>
<td>Then use the Left and Right arrow keys to</td>
</tr>
<tr>
<td></td>
<td>move the stop.</td>
</tr>
</tbody>
</table>

### Interaction

| Interact with an item                      | Control-Option-Shift-Down Arrow              |
| Stop interacting with an item             | Control-Option-Shift-Up Arrow                |
| Perform the default action for a selected | Control-Option-Space bar                     |
| item                                       |                                              |
| Select a menu or list item                | Control-Option-Return                        |
| Select multiple items                     | Control-Option-Command-Space bar             |
|                                            | Turn off cursor tracking to use this command.|
| Click the item under the mouse pointer    | Control-Option-Shift-Space bar               |
|                                            | Press once for a single mouse click and two  |
|                                            | times to double-click.                       |
| Open or close a disclosure triangle        | Control-Option-Backslash (\)                 |
| Read a row in a table or outline          | Control-Option-R                             |
| Read the column header in a table or      | Control-Option-Shift-C                       |
| outline                                    |                                              |
| Sort a column                              | Control-Option-Vertical line (|)             |
| Interact with scroll bars                 | Control-Option-Shift-S                       |
|                                            | Then use the arrow keys to scroll up or down |
|                                            | or side to side. Use Page Up and Page Down   |
|                                            | to scroll vertically one page at a time. Use  |
|                                            | Shift-Page Up and Shift-Page Down to scroll  |
|                                            | horizontally one page at a time.             |
| Resize a window                            | Control-Option-Tilde (-)                     |
|                                            | Then use the arrow keys to make the window   |
|                                            | taller, shorter, wider, or narrower. Use     |
|                                            | Shift with the arrow keys to resize in smaller increments.|
| Move or drag a window                      | Control-Option-Accent (´)                    |
|                                            | Then use the arrow keys to move the window.  |
|                                            | Use Shift with the arrow keys to move in     |
|                                            | smaller increments.                          |
| Stop scrolling, resizing, or dragging      | Control-Option-Escape (Esc)                  |